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Legal Information

Legal Information

The Schneider Electric brand and any registered trademarks of Schneider Electric Industries
SAS referred to in this guide are the sole property of Schneider Electric SA and its subsidiaries.
They may not be used for any purpose without the owner's permission, given in writing. This
guide and its content are protected, within the meaning of the French intellectual property code
(Code de la propriété intellectuelle frangais, referred to hereafter as "the Code"), under the laws
of copyright covering texts, drawings and models, as well as by trademark law. You agree not
to reproduce, other than for your own personal, noncommercial use as defined in the Code, all
or part of this guide on any medium whatsoever without Schneider Electric's permission, given
in writing. You also agree not to establish any hypertext links to this guide or its content. Sch-
neider Electric does not grant any right or license for the personal and noncommercial use of
the guide or its content, except for a non-exclusive license to consult it on an "as is" basis, at
your own risk. All other rights are reserved.

Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.

As standards, specifications and designs change from time to time, please ask for confirmation
of the information given in this publication.
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Safety Information

Safety Information

Important Information

Please Note

Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of poten-
tial hazards or to call attention to information that clarifies or simplifies a procedure.

g The addition of either symbol to a "Danger" or "Warmning" safety label
? indicates that an electrical hazard exists which will result in personal
injury if the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential per-
sonal injury hazards. Obey all safety messages that follow this symbol

to avoid possible injury or death.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or ser-
ious injury.

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid
the hazards involved.
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Safety Precautions

Safety Precautions

During installation or use of this software, pay attention to all safety messages that occurin the
software and that are included in the documentation. The following safety messages apply to
this software in its entirety.

A WARNING

UNINTENDED EQUIPMENT OPERATION

Do not use the software for critical control or protection applications where human or
equipment safety relies on the operation of the control action.

Do not use the software to control time-critical functions because communication delays
can occur between the time a control is initiated and when that action is applied.

Do not use the software to control remote equipment without securing it with an author-
ized access level, and without including a status object to provide feedback about the
status of the control operation.

Failure to follow these instructions can result in death or serious injury.

A WARNING

INACCURATE DATA RESULTS

Do not incorrectly configure the software, as this can lead to inaccurate reports and/or
data results.

Do not base your maintenance or service actions solely on messages and information dis-
played by the software.

Do not rely solely on software messages and reports to determine if the system is func-
tioning correctly or meeting all applicable standards and requirements.

Consider the implications of unanticipated transmission delays or failures of com-
munications links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.
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Introduction

Introduction

Each field deployed Power Monitoring Expert (PME) 7.2.2 system is unique. Some systems have
been modified very little from the factory defaults, while others may have been completely cus-
tomized. In PME, the various configuration items and settings are stored in different locations and in
different formats. Most of the configuration items and settings stored in a file or in the database are
easy to migrate in bulk to the new system; however, a few must be recreated individually in the new
system.

This guide is designed to help you move an old PME configuration to a new PME 8.1 system.

Note: In this document, PME 8.1 is used when discussing the procedural steps. However,
these steps also apply to the following PME versions:

*» PME 8.1 Data Center Edition
» PME 8.1 Healthcare Edition

IMPORTANT! The upgrade procedures in this document refer to the standard PME install
path: . ..\Power Monitoring Expert\... Theinstall folder names for the Data

Center and Healthcare editions are different:

» . .\Power Monitoring Expert DC Ed\...

» . \Power Monitoring Expert for Healthcare\...

Side-by-side Upgrade

A side-by-side upgrade is used when an older version of the software is upgraded to a newer ver-
sion, and the software needs to be moved to a new computer. This type of upgrade is referred to as
side-by-side because both systems—the old and the new—exist at the same time but on different
computers.

Common reasons for moving the software to a new computer during an upgrade include:

» Either the operating system (OS) version or the database (DB) server version or both on

the old PME system is no longer supported in the new system.

? The computer hardware of the old PME system is outdated and needs to be replaced or

upgraded.

” The old system cannot be decommissioned until the new system is fully deployed.

? You want to start with a fresh computer environment for the installation of the new version

of the software but retain the configuration of the old system.

© 2016 Schneider Electric. Allrights reserved. Page 11 of 100
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Side-by-side Upgrade Package

Purpose

Challenges

This guide assumes that you are using the Side-by-Side (SBS) Upgrade Package to assist in the
upgrade process. The SBS Upgrade Package contains upgrade tools and a folder structure to help
you organize and prepare both systems for upgrade.

Note: Depending on the old and new systems, you might not need to use all the folders in
the SBS Upgrade Package. For example, if you are not upgrading a data center, ignore the
Data Center Images folder.

This document is intended for Application Engineers, system integrators, or other qualified project
execution teams who are responsible for the upgrading and configuration of an old PME system to a
newly installed PME 8.1 system on a different computer using the side-by-side approach. It
includes step-by-step instructions and defines prerequisites for the tasks involved. Experience
using previous versions of the software is recommended.

The challenges with completing this system migration include:

? Thereis no automated way to transfer the configuration.

? Many variations of the operating system (OS) and database (DB) systems are possible.
» PME can be installed as a standalone or distributed system.

? The migration can be time consuming.

» Many configuration items and settings need to be migrated.

This document addresses these challenges and provides the necessary information and procedures
to plan and execute the migration successfully. However, each migration in the field provides new
challenges and risks that need to be assessed and managed.

Areas not discussed in this document include integration with third party systems. Make sure you
understand the application environment in which the PME system exists so you can include this in
your migration plan.

When in doubt regarding any aspect of the migration, contact Schneider Electric technical support
engineers to discuss the migration before going on site.

Configurations

PME 8.1 supports a number of different OS and DB versions and can be installed as standalone or
distributed systems. Because of this version support, there are a large number of possible migration
scenarios between the old PME system and the new PME system. For a comprehensive list of
options, refer to the Power Monitoring Expert 8.1 Installation Guide that is delivered with the soft-
ware.

Below are some examples of common configurations.

Page 12 of 100
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Introduction

Old system: PME 7.2.2

. Small Power Monitoring Expert | Large Power Monitoring Expert

OS: Windows 7 Windows Server 2012 R2
DB: SAQL Server2012 Express SQL Server 2012 Standard

New system: PME 8.1

. Small Power Monitoring Expert | Large Power Monitoring Expert

OS: Windows 8.1 Windows Server 2012 R2

DB: SAQL Server 2014 Express SQL Server 2014 Standard

Common Migrations types:

Migrate From (Power Monitoring Expert) | Migrate To (Power Monitoring Expert)

Small Standalone System Small Standalone System
Small Standalone System Large Standalone System
Large Standalone System Large Standalone System
Large Standalone System Large Distributed System
Large Distributed System Large Distributed System

If your situation does not exactly match any of the scenarios above, you can still use this document
to help you with the migration process. Many of the steps are PME specific and do not vary much
between the different OS and DB systems. However, expect to spend extra time on researching
scenarios that might not be covered in this document. Extra risk may also be involved as we did not
test your particular migration scenario for this document.

Prerequisites

Before starting, take the time to plan the migration. Review this entire document to understand the
procedures involved and the skills required to complete the tasks. Make sure you have the neces-
sary tools and information available at the time the tasks are performed. In particular, consider the
following:

» Make sure you have a copy of the SBS Upgrade Package that is distributed with this doc

ument. This package contains tools to help you with the migration.
»” You need access to the PME 8.1 Install medium (DVD or .iso file).
' You need Administrator privileges on both the old and the new computer.
' You need Supervisor privileges for the old PME system and PME 8.1 systems.

? Both systems must be in the same language. You cannot change the PME language dur-

ing an upgrade.

© 2016 Schneider Electric. Allrights reserved. Page 13 of 100
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»

»

»

B

»

The old PME system must be in a functional state.

Review the IT Infrastructure Preparation for StruxureWare™ Guide.

This guide is written for IT administrators to help them prepare their IT system for an
upcoming installation of the PME software. The guide explains the system prerequisites
needed to enable a successful installation and commissioning of the software. Example
prerequisites include Windows account creation and server ports.

The new PME 8.1 system must be installed on a different computer and must be in a func-

tional state.

Custom report packs must be upgraded to be compatible on the new PME 8.1 system. If
you transfer non-upgraded report packs to the new system, you will not be able to use any

reports. See "Troubleshooting Reports" on page 91 for more information.

The licensing system has changed from previous releases. The new PME 8.1 system
includes a 90-day trial license for all features of the product. You must activate all valid pur-
chased software licenses within 90 days, or some software functionality is disabled. Cus-
tom Reports or configuration tools that have been previously purchased with a license
might require a license upgrade to continue using them after the upgrade. See "License the

New System" on page 21 for more information.

Note: For details on how to install PME 8.1, refer to the Power Monitoring Expert 8.1 Install-
ation Guide that is delivered with the software.

Custom Report Packs

A custom report pack contains one or more custom reports that are not part of the default PME soft-
ware. Report customization can range from simple — such as adding custom images — to advanced;
relying on complex folder structures or requiring DLLs that were compiled using older versions of the
.NET framework.

Because of these variations, custom report packs must be upgraded to be compatible on the new
PME 8.1 system.

If the old custom reports have been upgraded to be compatible with PME 8.1, follow the instructions
in this guide to install the report packs to the new system. All reports, custom and default, will work
as expected.

IMPORTANT! If you transfer saved custom reports that were not upgraded to the new sys-
tem, you will not be able to use ANY reports in the new system; including the default

reports.

See "Troubleshooting Reports" on page 91 for information on using non-upgraded custom report

packs.

Page 14 of 100
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Competencies

To maximize your chance of successfully completing the tasks described in this document, you
should:
?* Be familiar with the Power Monitoring Expert 7.2.2 and PME 8.1 software products.

? Have some experience running scripts in SQL Server Management Studio, and attaching,

detaching, and restoring SQL databases.

? Be familiar with the Windows Operating System.

» Have some experience editing the Windows System Registry.

» Know how to stop and start Services in the Windows Services application.

» Know how to run command line tools at a DOS command prompt.

? Know how to restart Internet Information Services (11S) using 11S Manager.

Estimated Upgrade Time

Introduction 20 minutes
Step 1 — Prepare both systems 60 minutes (+ possible troubleshooting time)

Step 2 — Copy the configuration of 30 minutes + 1.5 min/GB database size (ION_Data, ION_
the old system Network, ApplicationModules, Archives)

Step 3 — Identify Settings that must 30 minutes
be Individually Transferred

Step 4 — Transfer the Configuration 60 minutes
into the New System

Step 5 — Upgrade the Transferred 150 minutes + 4 min/GB database size (ION_Data, ION_
Configuration Network, ApplicationModules, Archives)

Step 6 — Configure the Individually 90 minutes (+ possible troubleshooting time)
Transferred Settings

Step 7 — Perform a Post-upgrade 60 minutes (+ possible troubleshooting time)
System Check

Total upgrade time* = 500 minutes (8.33 hours)
* Does not including database transfer or possible troubleshooting time.

Glossary

Certain acronyms, abbreviations, and technical terms are used throughout this document and are
defined in the table below.
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Database A computer in a distributed PME system that is running the SQL database server
Server software and the PME databases.

See “Distributed System” for more details.

DB Database (e.g., SQL Server 2008 R2).
DC Data Center
Device A meter or a point of data collection.

Distributed A PME installation where parts of the system are installed on different computers.
System Several combinations are possible, but the most common is the separation of the
PME applications and the Database server onto different computers.

For example, a simple distributed install would have all the PME relevant programs
and services installed on one computer and SQL Server with the PME databases
installed on a second computer. In this case, the computer running the applications
is called the Primary server, and the computer running SQL Server is called the
Database server.

A distributed system can also have Web client computers that run Web browsers to
view the PME Web applications such as Dashboards, Tables, Alarm Viewer, and
Reports inside the Web framework.

Download  Standard Edition (SE)— Full support including logs etc; may be released as an
able installer but will become native in the subsequent release of PME.
Devices
Limited Edition (LE) — Only real-time and PC based logging; created and supported
by Schneider Electric; will never become native.

Custom Edition (CE) — Only real-time and PC based logging; created by Schneider
Electric or 3rd party. CEs are used on an as-is basis; they were previously referred
toas L2 or Jenny Type device drivers.

SE and LE drivers are available in the download area and can be released as
dPacks.

CE drivers are available on the Marketplace as-is.

ENM Event Notification Module

HC Healthcare

1S Internet Information Services

(O] Operating System

PME Power Monitoring Expert

Primary Computer in a distributed PME system that is running all of the PME applications
Server and services. See “Distributed System” for more details.

SSDT SQL Server Data Tools

SSMS SQL Server Management Studio
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Standalone A single computer running all parts of a PME system. See “Standalone System” for
Server more details.

Standalone A PME installation where all parts of the system are installed on the same com-

System puter, i.e., all applications and services, the SQL database server, and the data-
bases are on a single computer. This single computer is then referred to as
Standalone Server.

A standalone system can also have Web client computers which are running Web
browsers to view the PME Web applications like Dashboard, Tables, Alarm Viewer,
and Reports inside the Web framework.

VM Virtual Machine (as compared to a physical computer).

Web Client A computerin a PME system that runs a Web browser to view the Web applications
like Dashboard, Tables, Alarm Viewer, and Reports inside the Web framework.

Both standalone and distributed PME systems can have Web clients.
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Upgrade Process

Upgrade Process

Note: Due to modifications in PME, the side-by-side upgrade process has changed
since the previous PME release.

Each field deployed system is unique. Some systems have been modified very little from the
factory defaults, while others may have been completely customized. In PME, the various
configuration items and settings are stored in different locations and in different formats. Most
of the configuration items and settings stored in afile or in the database are easy to migrate in
bulk to the new system; however, a few must be recreated individually in the new system.

The upgrading of the configuration from the old system to the new system is accomplished in
seven steps and must be done in the following order:

?* "Step 1 — Prepare both Systems" on page 20

?» "Step 2 — Copy the Configuration of the Old System" on page 25

7' "Step 3 — Identify Settings that must be Individually Transferred" on page 32

?* "Step 4 — Transfer the Configuration into the New System" on page 37

?» "Step 5— Upgrade the Transferred Configuration" on page 52

** "Step 6 — Configure the Individually Transferred Settings" on page 72

?» “Step 7 — Perform a Post-upgrade System Check" on page 82

The detailed steps to upgrade the configuration are covered in this section.

Note: The old PME system can keep running while the configuration is upgraded.
However, you might experience some performance degradation if two systems are
working with the devices.

Note: The procedural steps covered in this document do not include configuring new
features in PME 8.1.
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Step 1 — Prepare both Systems

Before starting the upgrade process, it is important to understand the operational state of both
the old and the new systems.

Assess the Old System

Assess the old system by completing the following procedures:

1.

Review the old PME system to see if Devices, Vista Diagrams, Reports, and any

other configurations are working as expected.

Check the system log for errors. Correct any items in error or note them down so

you can address them on the new system after the migration.

Check the size of the historical data database (ION_Data) and look for database

archives that need to be migrated.

Consider timming or emptying the PQ_Events table from the ION_Data table; this
can always be rebuilt if needed. This table can get quite large and might not be

needed on the new system.

Check the size of other tables and databases and consider what is needed in the
new system. Upgrading these tables can take a very long time if there are large
amounts of data being transferred and upgraded. Trim large databases to avoid long

upgrade times.

Determine whether the old report packs have been upgraded to work on the new sys-

tem. See "Custom Report Packs" on page 14 and "Troubleshooting Reports" on

page 91 for more information.

Run the Diagnostic Tool thatis foundat . . .\ [Install location]\Sch-
neider Electric\Power Monitoring Expert\Diagnostics

Tool\Diagnostics Tool.exe.

The Diagnostics Tool output provides a snapshot of the current state of the system. Review-
ing this helps in identifying current or potential issues. It is advised that you select all the com-
mands to run to get a full view of this system. Unzip the files (if compressed) and open the
HTML page by clicking on index .html foran overview of the results. Fix any issues as
needed before upgrading.

Page 20 of 100
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Note: The migration of the ION_Data database is often the most time consuming
part of the system migration. You can expect this process to take about 1 hour for
each 15 GB in database size. It is often better to trim the database or archive portions
that are no longer needed before the migration. This is especially important for large
database sizes. Plan this part of the migration carefully.

Assess the New System

Note: The procedures in this document are based on the assumption that PME 8.1 is
installed correctly on the new computer, and that it is in a factory default configured
state. Any custom configuration that exists on the new system will be overwritten by
the migration procedures in this document.

Assess the new system by completing the following procedures:

1. Check a few of the basic functions such as the system log for errors, and inspect

the System Configuration Report.

2. Open the Web Application and ensure that there are no Dashboards and that the

default Web Reports are available.

3. Runthe Diagnostic Tool thatis foundat . . .\ [Install location]\Sch-
neider ElectricPower Monitoring Expert\Diagnostics Tool\Dia-
gnostics Tool.exe

After confirming the installation is working correctly, assess whether the new system has

enough available hard disk space to accommodate the PME databases and the database
upgrade procedures.

Note: You should have at least four times the size of the PME databases in free hard
disk space to allow for: backups, disk usage during the database upgrade process,
and increase in the database size after the upgrade.

License the New System

The installed software includes a 90-day trial license for all features of the product. You must
activate valid purchased software licenses within 90 days, or some software functionality is
disabled.

For information on licensing, refer to the Power Monitoring Expert 8.1 Installation Guide. To
find to the installation guide, open the Management Console > click Help > Installation
Guide.
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For quick answers to the most common licensing questions, refer to the PME Licensing
Guide. (You will need to provide your PME Exchange Community login credentials.)

Refer to the online help in Schneider Electric Floating License Manager for additional inform-
ation.

Contact the Software Registration Center if you experience any problems activating your soft-
ware licenses. Click Help > Support in Schneider Electric Floating License Manager for the
contact information.

Prepare the Side-by-side Upgrade Package

The Side-by-Side (SBS) Upgrade Package contains upgrade tools and a folder structure to
help you organize and prepare both systems for upgrade.

In subsequent steps you will copy configuration files from the old system to SBS Upgrade
Package folders, use the tools to facilitate the upgrade, and then copy the entire
SBS Upgrade Package to the new system.

To prepare the SBS Upgrade Package:

Locate the SBS Upgrade Package and copy it to the C: \ drive of the old system.

./ 5B5 Upgrade Package
. config
| Dashboard_Images
. Data_Center_Images
, Database_Archives

. Database Backups

| EWS
. Report_Subscriptions
, SOQL_Script_Files

Distributed System Note: If the old PME system is a distributed system, copy the
SBS Upgrade Package on the Primary and the Database Server in the following man-
ner:

On the Primary Server:
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, 5B5 Upgrade Package
, config
. Dashboard_Images
. Data_Center_Images
; EWS
. Report_Subscriptions
J SQL_Script_Files

On the Database Server:

| SBS Upgrade Package
|. config
| . Database_Archives
| Database_Backups
| SQL Script_Files

At this point, the following folders are empty:

” \config

» \Custom_ Reports

» \Dashboard Images

» \Data Center Images

» \Database Archives

» \Database Backups

? \EWS

\Report Subscription contains the following files:

ExportSubscriptions.exe
gacutil.exe
ImportSubscriptions.exe

? IONSubscriptionsHelper.dll

\SQL Script Files contains the following files:

» Fix PME Users.sql

” SSDT_cmd_Line.bat
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» update server name in archive databases.sqgl

” update server name in live databases.sql
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Step 2 — Copy the Configuration of the Old System

After assessing the old and new systems and ensuring they are operating properly, copy the
old PME system configuration components to the SBS Upgrade Package.

Copy Database Backups and Archives

The database backups from the old system need to be copied to the SBS Upgrade Package.
The following databases from the old system must be backed up:

>’ JON_Data (contains the historical data and event logs)
?* |ON_Network (contains the configuration information)

?* ApplicationModules (contains the Web application related information)

Note: Do not copy a backup of the System Log database; it contains information rel-
evant to the old PME system. The new PME system has its own System Event log.

Distributed System Note: The databases and archives are located on the Database
Server.

To back up the system databases and database archives:

1. Open SQL Server Management Studio and connect to the PME database instance.

Note: You can find the location of the database files by viewing the Properties
of the database in SQL Server Management Studio.
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2. Right-click the ION_Data database and then click Tasks > Back Up.
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[# [ System Databases
@ [3@ Database Snapshots
] [__] ApplicationModules

= (3 EE=
Z l_j ION_ I New Database...
= u ION_S New Query
& [CJ Security Script Database as
@ 3 Server Ob
® 3 Replicatig =k
& 3 AlwaysOr Policies
= [ Managemr Facets
& [d Integratio
= L% SOl Serve Start PowerShell
Reports

Detach...

Take Offline

Bring Online

Shrink 3
Back Up...

Restore 3

3. Name the backup file ION Data and backituptothe ...\SBS Upgrade Pack-

age\Database Backups folder.

© 2016 Schneider Electric. Allrights reserved.
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_. Back Up Database - ION_Data _ | O
Select apage L6 Seript = [ Help
% General
12 Options
Source
D atabaze: I [OM_Data j
Fecoven model: ISIMF‘LE
Backup type: IFuII j

r Copy-only Backup
Backup component:

' Database

£ Files and filegroups: I |

Backup zet
Mamne: IID W_Data-Full Databaze Backup

Dezcription: I

Backup zet will expire:

o After: ID ﬁ days
Connection  On | 3/ 1726 =
Server Destination
standalone 0N Back up to: &+ Disk i Tape
Connection: C:ASBS Upgrade PackagehDatabase BackupssIOM_Data Add
STAMDALOMNE Administrator
%‘# Wiew connection properties Fremove

LCantents
Feady
Ok Cahcel |

4

Note: You can expect this backup process to take about 15 minutes for a 10 GB data-
base.

4. Repeat this process for both the ION_Network and ApplicationModules databases.
Use ION_Network and ApplicationModules as the label names for the backup files.

Repeat this process to backup the database archives from the old system, using the name of
the archive as the name for the backup. Copy them tothe . . .\SBS Upgrade Pack-
age\Database Archives folder.

Copy config Folder

The config folder contains many of the system configurations in the old PME system.
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However, the following ..\Schneider Electric\Power Monitoring Exper-—
t\config files and folders are not needed for the migration and should not be copied:

»? The DatabaseRegistry.regfile

? The \config\cfg\DBBackups and \config\cfg\Archives folders. This is
where scheduled database backup and archive files are stored. These files tend to
be large and since we copied the archive files separately, there is no need to copy
them again.

> Any other database backups or archive files that might be stored in \config or any of
its sub-folders.

¥

The PowerShell scripts in..\Schneider Electric\Power Monitoring

Expert\config\cfg\DbScheduledTasks.

Copy the remaining content of the \ conf ig folder on the old systemtothe . . . \SBS
Upgrade Package\config folder.

Distributed System Note: Thereis a.. . \config folder on both the Primary
Server and the Database Server:

1. Copy the \config folder on the Primary Serverintothe .. . \SBS Upgrade
Package\config folder you created for the Primary Server.

2. Copy the \config folder on the Database Serverintothe .. .\SBS Upgrade
Package\config folder you previously created for the Database Server.

Custom Report Packs

The old system might contain custom report packs. These must be updated before you can
use them on the new system.

IMPORTANT! Some custom report packs may not upgrade correctly due to missing
thefile Content Types.xml and other modifications. Contact the provider of the
custom report pack BEFORE upgrading to PME 8.1 and ensure its functionality has
been tested on PME 8.1. See "Custom Report Packs" on page 14 and "Troubleshoot-

ing Reports" on page 91 for more information.

To check the old system for custom report packs:

1. Navigateto..\Schneider Electric\Power Monitoring Expert\web\Re-

portPacks\
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2. ldentify any custom report packs that exist on the old system.

3. Contact the report pack provider to obtain a PME 8.1 compatible version of these

report packs.

Copy Report Subscriptions

The SBS Upgrade Package includes a tool that copies the old system report subscriptions.
However, since report subscriptions in PME are handled differently depending on which SQL
Server edition is used, the tool does not work for certain SQL server edition upgrade scen-
arios.

2o .S.erver Scheduling Configuration Ul Schedule Details
Edition Tool

SQL Standard SQL Agent  Report Management Ul in Stored in msdb database
Web Applications (part of SQL Server)

SQL Express ION Task Report Management Ul in Stored in ION_Network data-
Scheduler Web Applications base

Use the following information to determine which upgrade process to use:

PME 7.2.2 m Upgrade Process

SQL Standard SQL Standard Use SBS Upgrade Package tool (see instructions below)
SQL Express SQL Standard Use SBS Upgrade Package tool (see instructions below)
SQL Standard SQL Express  Subscriptions must be recreated in PME (skip this topic)

SQL Express SQL Express Subscriptions are automatically transferred with the ION_
Network database migration (skip this topic)

Distributed System Note: Complete these tasks on the Primary Server.

To copy the report subscriptions:
1. Inthe ...\SBS Upgrade Package\Report Subscriptions folder, locate
ExportSubscriptions.exe and IONSubscriptionsHelper.dll.

2. Copythe2filestothe ...\Power Monitoring Expert\system\bin folder

on the old PME system.

3. As the Administrator, run ExportSubscriptions.exe.

The tool opens a command prompt and indicates when the task is complete.
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© | CAProgram Files (x86)\Schneider Electric\Power Monitoring Expert’\system‘\bin\E...l;li-

eport Subscriptions are exported into C:wProgram Files (x86)Schneider Electric
Power Monitoring Expertssystemsbin“I0ONSubscriptionData.xml
rezs any key to exit...

The output of the tool is afile called . . . \Power Monitoring Exper-—
t\system\bin\IONSubscriptionData.xml.

4. Press Enterto close the command prompt window.

5. Copy IONSubscriptionData.xml tothe ...\SBS Upgrade Pack-

age\Report Subscriptions)\ folder.
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Step 3 - Identify Settings that must be Individually
Transferred

The previous step resulted in copying configuration settings, such as the .. . \config folder
or the databases, to easily transferable locations.

For this section, examine the existing system for customizations that need to be individually
transferred and then decide which of these are needed on the new system.

Scheduled Tasks on the Old System

Windows Task Scheduler is used to schedule Power Monitoring Expert activities such as
database archive, trim, or backup. Any such tasks that exist on the old system need to be
manually recreated on the new system if desired.

PowerShell

Navigate to..\config\cfg\DbScheduledTasks\Support)\ and then open Con-
figuration.psl.

Note the following PowerShell script file settings:

» SlocationForBackupFiles

» SlocationForArchiveDBFiles

” SarchiveDBDaysToKeep

» SmaximumDatabaseSizeInGigabytes

»” SdatabaseSizeNotificationThresholdPercentage

» $diagnosticsDaysToKeep
Navigateto ..\config\cfg\DbScheduledTasks\ and then open Backup.psl.

Note the following PowerShell script file settings:

» SnumberOfBackupsToRetain

Compare these settings later with the settings on the new system.

OPC Measurement Definitions

PME ships with a factory default file that defines which measurements are available for the
different device types through OLE for Process Control (OPC).

It is possible to edit this file to add new device types and measurements. Changes made to
the existing OPC measurement definition file need to be manually copied to the new system.

To check OPC Measurement Definitions for changes:
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1. Navigatetothe ...\Schneider Electric\Power Monitoring Exper-

t\system\IONServices folder.
2. OpenDefaultMeasurements.xml.

3. Check the file and then note the changes that you want to recreate on the new sys-

tem.

Registry Settings

Some functions in PME are controlled by settings that are stored in the Windows registry.
Most of these settings — also called registry keys —are part of the default system install and
do not need to be transferred. However, some registry keys might have been added after the
install and transferred to the new system.

The most common custom registry keys are for:

» Specifying a custom network diagram (instead of using the default network diagram)

to be used in the Diagrams (WebReach) part of the Web Applications.

**Enabling linking of custom device types (for example, those created with the MDI)

to default diagrams in ION Vista.

This topic outlines how to:

?* Export the entire set of PME registry keys to a text file as a backup in case this

information is needed in the future.

? Locate for specific keys that are commonly added and that will have to be recreated

on the new system.

To copy the custom registry settings:

1. Start the Windows Registry Editor.

2. Navigate to the default location for Power Monitoring Expert

HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\Schneider Electric
[for 64-bit systems]

HKEY LOCAL MACHINE\SOFTWARE\Schneider Electric [for32-bit sys-
tems]

3. Right-click Schneider Electric and export the registry as a TXT file.
4. Copythe TXTfileinto ...\SBS Upgrade Package\

To find a customized network diagram key:
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1. Open the Windows Registry Editor and browse to:

HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\Schneider
Electric\ION Enterprise\7.2.2\WebReach [For64-bit systems].

HKEYiLOCALiMACHINE\SOFTWARE\SChHeider
Electric\ION Enterprise\7.2.2\WebReach [For 32-bit systems].

2. Search for a key named NetworkDiagram.

3. Write down the value of this key; it will look like a file path. For example: x-pml: /-

diagrams/ud/campus/campus_home.dgm

To find a custom device type key used for Vista diagram linking:

1. Open the Windows Registry Editor and browse to:

HKEY LOCAL MACHINE\SOFTWARE\Schneider
Electric\ION Enterprise\7.2.2\DeviceInfo [For64-bit systems].

HKEY LOCAL MACHINE\SOFTWARE\Schneider
Electric\ION Enterprise\7.2.2\DeviceInfo [For32-bit systems].

2. Compare the list of device types to the list of "Default Device Drivers" on page 84.

3. Write down the custom keys and values or export that section of the registry.

ION Login Password

The Modify Login action in Database Manager changes the SQL Server password for the
default login name ION.

To check whether the password has changed:

1. Open the Windows Registry Editor and browse to:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider
Electric\ION Enterprise\7.2.2\Databases [For64-bit systems]

HKEY LOCAL MACHINE\SOFTWARE\Schneider Electric\ION
Enterprise\7.2.2\Databases [For 32-bit systems]

If there is a key named Password, of Type REG BINARY, thenthe ION login has been
changed. You will need to find the password and manually change it using the Database Man-
ager tool on the new system.

If there is no such key, then the default password is used and no changes need to be made on
the new system.

Dashboard Images

To copy the dashboard images from the old system:
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1. InWindows Explorer navigateto . . . \Schneider Electric\Power Mon-
itoring Expert\Applications\ApplicationFramework

\BackgroundImages.

2. Copytheimagefiles ...\SBS Upgrade Package\Dashboard Images.

Data Center Edition Images

Note: This topic applies to PME Data Center Edition only.

1. InWindows Explorer navigateto . . . \Schneider Electric\Power Mon-
itoring Expert

DC Ed\Applications\ApplicationFramework\UserImages

2. Copytheimagefilesto ...\SBS Upgrade Package\Data Center Images

EcoStruxure Web Services (EWS) Configurations
By default, the EWS service is disabled in PME 8.1. It must be manually enabled.
If EWS is configured on the 7.2.2 system, it must be re-enabled in the 8.1 system.
To check for EWS customization on the old system:
1. In Windows Explorer navigate to..\Schneider Electric\Power Mon-
itoring Expert\Applications\EWS\ andthenopenweb.config.
2. Search for the following string:

» EWSEnabled

¥ Ifthe EwSEnabled valueis 1, then EWS is configured. If the value is 0, then it
has not been enabled and does need to be updated in the new system.

3. IfEWS is enabled, search for the following settings:

» EWSAlarmSortOrder

» ContainerItemStructure
» .

DisplayNanValue
» ConcatSourceAlarmEventId

» RealTimeRefreshRate
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4. Note the setting values; you will need to copy these to the EWS configuration on

new system.

To transfer any custom EWS device type definitions:

1. In Windows Explorer navigateto . . .\Schneider Electric\Power Mon-

itoring Expert\system\WebServices\Extensions\.

2. Copy the Extensions folderto . . . \SBS Upgrade Package\EWS.
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Step 4 — Transfer the Configuration into the New System

The topics in this section outline how to transfer the configurations from the old PME system
into the new PME 8.1 system.

Prepare the New System

On the new system, prepare for transferring the configuration by completing the following
steps:

Distributed System Note: Stop the services on the Primary Server.

1. Close all PME applications and use the Windows Services application to stop the
following services on the Primary Server (there are no PME services running on the
Database Server):

?  ApplicationModules AlarmServiceHost

» ApplicationModules CoreServicesHost

» ApplicationModules DataServicesHost

» ApplicationModules ProviderEngineHost

* |ON Alert Monitor

» |ON Component Identifier Service

? JON Connection Management Service

* |ON Event Watcher Service

? JON Log Inserter Service * (Disable the ION Log Inserter Service after stop-

ping it. See * below.)

» |ON Managed Circuit Service

» |ON Network Router Service

» |ON OPC Data Access Server
»” |ON PQDIF Exporter Service
” |ON Query Service

* |ON Real Time Data Service
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» JON Report Subscription Service

» |ON Site Service

”* |ON Software Alarm Service

»” JON Software Modbus Gateway Service

** |ON Virtual Processor Service
? |ON Virtual Processor Service -NVIP.PQADVISOR
? |ON XML Subscription Service

» JON XML Subscription Store Service

IMPORTANT NOTES:

»

»

e

»

»

* If this service starts accidentally before all changes are made, the database may

become inoperable, a state from whichiit is difficult to recover.

Ensure all services are stopped before proceeding.

Some services may have Startup Type set to Manual and may not be running.
ION services automatically restart when the computer is rebooted.

Until the PME installer automatically starts all the necessary ION services as part of the

upgrade configuration, the ION services must remain stopped.

Copy the SBS Upgrade Package to the New System

The SBS Upgrade Package must be copied to the new computer; for example by using a
removable drive to transfer the files.

Copy the .. .\SBS Upgrade Package folder and all its sub-folders to the C: Drive of the
new computer.

Distributed System Note: Copy the Database folders to the Database Server.
Copy the remaining folders to the Primary Server.

Transfer config Folder

Copy the entire . . .\SBS Upgrade Package\config folderand its contents to the
..\Schneider Electric\Power Monitoring Expert\config locationonthe new
system, overwriting any existing folders and files.

Segment Edition Note: This default file path is different for the PME Segment Editions.
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one of the following:

Distributed System Note: For situations involving distributed installs of PME, do

Old Sys- | New Sys-
tem Type | tem Type Import Steps

Distributed Distributed

Standalone Distributed

Copy the ...\SBS Upgrade Package\config folder from
the Primary Server to the new PME Primary Server. Copy
the.. .\SBS Upgrade Package\config folderfrom the
Database Server to the new PME Database Server.

Copy the .. .\SBS Upgrade Package\config folderto
the Primary Server as described above.

For the Database Server, copy the following . . . \SBS
Upgrade Package\configsub-folderstothe ...\Sch-
neider Electric\Power Monitoring Exper-
t\config folder on the Database Server:

? \AlertMonitor

» \diagrams

» \exporters

» \lvp

» \reports

» \templates

? \translators

Distributed Standalone Copythe ...\SBS Upgrade Package\config folderfrom

Transfer Dashboard Images

the Primary Server and the Database Server to the new PME
standalone server.

To transfer the dashboard images:

1. Copy the image files from . . . \SBS Upgrade Package\Dashboard Images to

...\Schneider Electric\Power Monitoring Exper-

t\Applications\SystemDataService\App Data\Images\Back-

groundImages.

Note: Do NOT overwrite files in the target folder.
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Transfer Data Center Edition Images

Note: This topic applies to PME Data Center Edition only.

To transfer the Data Center images:

1. Copy theimage files from . . . \SBS Upgrade Package\Data Center Images
to...\Schneider Electric\Power Monitoring Expert
DC Ed\Applications\SystemDataService\App Data\Images\En-

ergyGadgetImages.

Note: Do NOT overwrite files in the target folder.

Connect the Old Databases

You need to remove, rename, or delete the factory (new) database files before you can con-
nect the old databases to the new system.

Distributed System Note: Complete these steps on the Database Server.

Detach the Default Databases

Before you can remove, rename, or delete the factory installed ION_Data, ION_Network, and
ApplicationModules databases on the new PME system with the copies made from the old
PME system, you must first detach the factory installed databases.

To detach the ION_Data database from the new system:

1. Goto SQL Server Management Studio and right-click ION_Data > Tasks > Detach.

Note: If you cannot detach a database because of active connections, select
the Drop Connections option in the detach dialog in SQL Server Management
Studio. For example:
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Selecta page S Seipt + [ Help

Databases to detach:
Database Mame
IOM_Metworkc

. Updat... Status Message
[]  MNet.. 2Active connectionis)

2. Follow the same steps to detach the ION_Network and ApplicationModules

databases.

Remove, Rename, or Delete the Factory Databases

Detaching the databases will not remove the database files from the new PME folder struc-
ture. Since the old databases that you need to upgrade must be in the same location as the
factory ones, you need to delete, remove, or rename the factory database files. The factory
database files are located at . . . \Schneider Electric\Power Monitoring Exper-
t\Database\ApplicationModules, \Data, \Network.

1. Navigateto ...\Schneider Electric\Power Monitoring Exper-

t\Database\ApplicationModules, \Data, \Network.

2. Rename the factory database files.

For example:
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Harme Share Wi e

@ - 1 | o <« Schneider Electric » Power Monitoring Expert » Database » Data v G| | Search Data

-

B0 M3Build ~ Marme Date rmodified Type
B Motepad++
B OPC Foundation
B Reference Sssemblies
4 ) Scheeider Electric
L BWsclient
B ION Setup
4 1 Poweer Monitaring Expert

|| IOM_Data LDF_PMEST 31206 124 PR LDF_PRAERT File 1,536 KE
|| IOM_Data,MDF_PMEST 31206 124 PR rADF_PRAEST File 4,064 KB

Bl Applications
I 1. config
4 Database
o Applicationfodules
I+ [, Backup
. Data

L0 MNetwork
2iterns State:a Shared

Restore the Databases from the Old System

Restore the old databases to the new PME system at their default location:
?’ |ON_Data database: ..\Schneider Electric\Power Monitoring Exper-
t\Database\Data

? |ON_Network database: ..\Schneider Electric\Power Monitoring

Expert\Database\Network

» ApplicationModules database: ..\Schneider Electric\Power Monitoring

Expert\Database\ApplicationModules

To restore copies of the old PME databases into the new PME system:

1. In SQL Server Management Studio, right-click Databases and then click Restore

Database.

2. Click Device and then click ... (the ellipsis button).
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@ Mo backupset selected to be restored.

?ﬁdapﬂ:}e S Script ~ |lE Help
A General
(5 Files Source
A Options
O Database: |

£

| |

— %

- | 7]
Restore to: | | Timeline...
Restare plan
Backup sets to restore:

Restore  Mame Component Type Server Database Position  First LSM  Last LSN  Checkpoint LSN  Full L}

Connection
@ STANDALONENON [sa]

View connection properties
Progress
Ready

<| n [>

Verify Backup Media
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3. Click Add.

Specify the backup media and its location for your restore operation.

Backup media type: File
Backup media:

Remove

Contents

4. Inthe Locate Backup File dialog, navigate to the PME database file from the . . . \SBS
Upgrade Package\Database Backups folderand enter the database name in
the File name field.

For example:
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Backup File location:

C:A5BS Uparade F'ackage"uDatal:uase_Eackup| | (£ | |

E-C3 C

#-[3 $RecycleBin

- $wWINDOWS. ~BT
- DCF_Files

--ﬁ Dacuments and Settings
--ﬁ iretpub

--ﬁ Perflogs

--ﬁ Frogram Files

--ﬁ Frogram Files [x86)
--ﬁ FrogramD ata

=3 5BS Upgrade Package
--E] config

--E] Custar_Reports
--E] D atabaze_Archives
[ Databaze_Backups
--E] Report_Subscriptions
-0 SOL_Script_Files
+-[ 0 Syztem Yolume [nformation
+- 7 Users

+-[ ] WwarpMeters

~ 1 10M_Data
] ioM_Metwark

File namme:  |[1OM_Metwork,

| | &l Filesf*

k. Cancel

5. Click OK.

6. Make sure that Restore is checked:

ESScript - |E Help
Source
() Database: | v‘
® Device: |IC:\Schneidel_Backups\Database_Backups\lON_Nelwolk | El
Database: [10N_Network «ffm— v
5
Databasze: ||0N,Network v ‘
Restore to: |The last backup taken (Wednesday, March 25, 2015 123.3:1| Timeline...
Restore plan

Backup sets to restore:

Restore  Name
k-Full D

Comporert  Type  Server Database Position

Backup  Datab Full  STANDALONEVION  |ON_Metwork 2
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7. Click on the Files tab on the upper left of the window, click Relocate all files to

folder, and then select the location for restoring the database:

Io Ready

Select a page B seript + | [ Help
% General
g Fil§ h Restore datak files as
A Options
ﬂ [¥ Relocate all files to folder
Diata file folder : |C:\Program Files (x86)\Schneider Electric\Power Moni‘toring| IZI
Log file folder: |C:\Program Files (x86)\Schneider Electric\Power Monrtorlng| IZI
Logical File Mame  File Type Original File Name Restore As
chprogram files (x86)\5chnei..  C\Program Files (x86)\5chnei... E|
10M_Metwork_. Log ciprogram files (x86)\Schnei..  C:\Program Files (x86)\Schnei... E|
Connection
A7 STAMDALONEVOM [sa)
View connection properties
Progress
@ Done
QK ‘ ‘ Cancel | | Help |
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8. Select the default location for the PME databases. For example:

]

Locate folder

Select the folder:

BE |

-7 Java
+ - Microzoft Analyzsis Services
-7 Microsoft Office
; - Microsoft SDkz
H-{ 3 Microsoft SAL Server
H-{ 3 Microsoft Wisual Studio
H-{ 3 Microsoft Wisual Studio 10.0
H-{ 3 Microsoft WWorks
H-{ 3 Microsoft HET
¢ MSBuild
H-{ 3 Motepad++
H-{ 3 OPC Foundation
H-{ 3 Reference Azsemblies
1__] Schneider Electric
+- 1 EwSclient
+- 10M Setup
= - Power Monitoring Expert
+1__] Applicationsz
+1__] config
—-3 Databaze
: +1__] Applicationtodules
<0 Data
SR ] M etwork
: - 1 Swyatembog
+ H-{ 3 diagnostic
+ H-{ 3 Diagnostics Tool
+ H-{ 3 Floating License Manager
Gy g I |
gy

+
+
+
+
+
+
+
+
+

License Manager
4 Setuoloos

b

Selected path:

C:%Program Files [«86)45 chneider ElectrichPower b|

| | Cancel

9. Click OK.

The following image shows the restored databases:
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Object Explorer * 1 X

Connect~ & 4 m [ g] S
= [y STANDALONE\ION (SOL Server *
S Databases
[ System Databazes
[ Database Snapshots
IJ ApplicationModules
IJ [OM_Systernlog
|| 1ON_Data
| J 1ON_Network
[ Security
[ Server Ohjects

[,

Note: You can expect the database restore to take about 5 minutes for a 10 GB data-
base.

Restore the Archive Databases to the New System

Since the new PME system does not have a default folder location for database archives, cre-
ate afoldercalled..\Schneider Electric\Power Monitoring Exper-
t\Database\Archives.

Repeat steps 1 through 9 above, restoring the archive databases to this folder.

For example:
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Select the folder:

- Intemet Explorer

- Java

--E] Microzoft Analyzis Services

- Microzoft Office

- Microzoft SDKs

- Microsoft Silverlight

- Microzoft SOL S erver

- Microsoft Yisual Studio 10.0

- Microsoft MET

-3 MSBuild

- Notepad++

-3 OPC Foundation

-1 Reference Aszemblies

=3 Schneider Electric

-0 EwWSclient

- 10N Setup

EH:] Power Monitaning Expert
-3 Applications
- config
=3 Database

#-L Ap

-

-3 Data
- Metwork
- Syatemlog
+-[ 1 diagnostic
+-[J Diagnostics Toal

+- 4 Floating Licensze Manager e

Selected path: | C:AProgram Files (86185 chneider ElectichPower I*l

| ak. || Cancel |

Import Custom Report Packs

Note: Upgrading custom reports is not within the scope of this SBS upgrade pro-
cess. Contact your report provider to upgrade the old reports to PME 8.1. Once
upgraded, you can install them on the new PME system.

Importing the upgraded custom report packs into the new PME system is a 2 step process:
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1. Copy the upgraded report packs into the new system.
2. Install them on the new PME system.

You will complete the first step now; step two will be completed later.

Distributed System Note: Complete this step on the Primary Server.

To copy the report pack into the new system:

1. Copy all upgraded report packs to ..\ Schneider Electric\Power Mon-

itoring Expert\Web\ReportPacks\.

Import Report Subscriptions

Since report subscriptions in PME 7.2.2 and PME 8.1 are handled differently depending on
which SQL Server edition is used, use the following information to determine which import pro-
cess to use:

PME 7.2.2 m Import Process

SQL Standard SQL Standard Copy the SBS Upgrade Package report subscriptions to
the new system (see instructions below)

SQL Express SQL Standard Copy the SBS Upgrade Package report subscriptions to
the new system (see instructions below)

SQL Standard SQL Express  Subscriptions must be recreated in PME 8.1 (skip this
topic)

SQL Express SQL Express Subscriptions are automatically transferred with the ION_
Network database migration (skip this topic)

Distributed System Note: Complete the following steps on the Primary Server.

To import the report subscriptions:

1. Copy the contents of the . . . \SBS Upgrade Package\Report Sub-
scriptions\folderintothe..\Schneider Electric\Power Monitoring
Expert\system\bin\ folder.

The report subscriptions will be installed in a subsequent step.

At this point, all of the old PME configuration has been moved to the new system and is ready
to be upgraded and installed on the new PME system.
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IMPORTANT! The configuration is still NOT ready for use. More steps are required

to upgrade the configuration to make it compatible with the new system.
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Step 5 — Upgrade the Transferred Configuration

To upgrade the transferred configuration on the new system, complete the tasks in this sec-

tion.

IMPORTANT! The new PME system is NOT in a functional state. You cannot start
the services or run the applications. Make sure you follow the exact sequence
provided below. Whether done manually or by using the SQL script, the databases

MUST be upgraded before the server name changes are made.

Upgrade ION_Data, ION_Network, and archived databases

IMPORTANT! Make sure the new system has at least four times the size of the
PME databases in free hard disk space to allow for: backups, disk usage during the

database upgrade process, and increase in the database size after the upgrade.

Use the Database Manager tool in PME to upgrade the databases for ION_Data, ION_Net-
work, and archive databases. Since the system is not yet functional, you cannot start PME
Management Console to access the Database Manager. To open this tool, start Data-
baseManager.exe fromthe. \Schneider Electric\Power Monitoring Exper-
t\system\bin folder.

. translatars
o WehReach

= (%] DevExpress.Datavl10.2.dll
(%] DevExpress.Utilswv10.2.d1l

T/3LF013 434 A0
T/3LF013 434 A0

2378 KB T3
3I0KE T3

Application extens..,
Application extens..,

oo sl
@7(:)-\ | < Pragrarn Files (36) » Schreider Electic + Power Manitoring Expert b systern b bin » « [ 44 ][ Search bin ol
Organize « Open Share with + New folder = ~ [ @
L system * Mame ’ Date madified Type Size Date o1 *
I bin (%] Data.Comrmaon.dll T/3L2013 L30PM Application extens.., 68 KB T/3L2
11 Diagrarns 2] Data.Reporting,Data.di TALIILIPM  Application extens... KB 1AL
I doe (%] Data.Reporting.dil T/3L2013 L30PM Application extens.., 41KB  T/3L72
b etc [%| Databasefrchive dil T/L2013 L30PM Application extens., 14KB  T/3L72
I+ Bxtensions [%| DatabaseBackup.dll T/L2013 L30PM Application extens., 13KB T3l
1 10N Senvices %8| DatabaseManager.Cantrol.dil TAL013 130 P Application extens., 0K 1L
I ReportDataSerdce > 2 DatabaseManager.ex: TAYAI LI PM Bpplication TAKE 73172
I reports (%] DatabaseTrim.dll 7312013 30 PM Application extens.., 12KB T/3172
I schemas (%] DatabaseUtilities.dll T/31/2013 L30PM Application extens... KR T
L seripts [ Databaselltlities.dll.config TaL2013 424 80 ML Configuratio.., 1KE 7/3172
11 stylesheets designer.exe TALIILIPM  Applicstion SESTKE /3102
A
A
¥

| SmartBear - 4

. Uninst_JOMEnterprise
o Uninst_PME 7.2 Cumulative Update 3

WfebServices (%] DevExpress.XtraBarswl0.2.dll

%] DevExpress.XtraBditorsw10.2.d1l
(%] DevExpress.XtraGridaw10.2.dll

| web ] DevBxpress dtral ayoutay10,2.dll

TI3LF2013 K34 80
TI3LF2013 K34 80
TI3LF2013 K34 80
T/A1F013 434 A0

L83IKE 73172
LI04KE 73172
Application extens.., LIB3KE 73172
Application extens... GO0 KR T/A1E -

Application extens..,
Application extens..,

1

| b

| ExportsSubscriptions.exe State: 3B Shared
F Application Date modified: 8/22/201212:37 AM

Size: 7.00 KB
Date created: 1/13/2014 9:14 AM
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Distributed System Note: Complete these steps on the Database Server.

Note: Upgrading large databases is a time consuming process. Expect this to take
approximately one hour for each 15GB of database size. Also, the disk space
required for the upgrade can be as much as 4 times the size of the original database.
Make sure there is sufficient disk space for this upgrade.

IMPORTANT! Upgrade the ION_Data database first, before you upgrade the ION_
Network database or any other archived databases.

To upgrade the database:

1. In Database Manager, select Upgrade Databases.

Eile Wiew Help

= Database Manager
= EN2MZRZSTDNON

I Archive...

I Export Registry Satting...
! Modify Login...

Mew ION Databases..,
Trim...

* Upgrade Databases...

2. Select ION_Data for upgrade.

|Upgrades selected IOM database to the |atest version.

Database to upgrade: [OM_Data v

10N Data
IOM_Metwork
ION_SystemLog

ION_Data Upgrade is Complete
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Database Manager -

o The task completed successfully

0K

3. Repeat steps 1 and 2 to upgrade ION_Network and any archived databases.

The ApplicationModules database follows a different process. See the steps below to
upgrade this database.

Upgrade ApplicationModules Database

PME Segment Edition Note: The default path for any of the PME Segment Editions is dif-
ferent and needs to be changed to reflect this.

1. Navigatetothe .. .\SBS Upgrade Package\SQL Script Files folderand

use a text editor to open SSDT cmd_Line.bat.

2. Before running the script, make the following changes to the file in this order:

a. Inatexteditoropen SSDT cmd Line.bat, right-click and select
Edit.

SSDT _cmd_Lins hat 279770

E% Update_5ch Open

=} update_sen Edit h

=y update_sen Print
=} update_sen '@' Run as administrator
T-Zip »

Restore previous versions

Send to »

b. Verify the Microsoft SQL Server path is correct. Edit the path if it is not
the following:

SET "PathToSglPackage=Microsoft SQL Server-
\120\DAC\bin\sglpackage.exe"

c. Verify that the SQL path and the SQL Instance are correct. Change if

different from the following:

Page 54 of 100 © 2016 Schneider Electric. Allrights reserved.



Upgrade Process

?» The MDFPath and the LDFPath need to reflect the SQL
Version being used and the SQL Instance respectively,
NOT the database path.

” SQL 2008R2 will be MSSQL10_50.<SQL

Instance>\MSSQL\DATA

? 3QL 2012 will be MSSQTL11 . <SOL

Instance>\MSSQL\DATA

7 3QL 2014 will be MSSQL12 . <SOL

Instance>\MSSQL\DATA

d. (Optional) If the PME system is not installed at the default file location,
edit the following parameter to match to the system’s exact file path:

SET PMEPath=C:\Program Files (x86)\Schneider Elec-
tric\Power Monitoring Expert

3. After saving the file, execute it by double-clicking on the file name.

File Edit Format View Help

EBECHD OFF

SETLOCAL

11 Settings

:: Do not put guotes around the paths in these settings.

:: They are quoted when they are used in the script and double
1! quoting will cause problems.

SET PathTosglPackage=Microsoft sQL Server’\120%Dac‘bin‘sqlpackage. exe

SET DatabaseServerName={local)

SET MDFPath=C:“Program Files'Microsoft sQL Server'MssQL12.ION'MSSQOLYDATA

SET LDFPath=C:“Program Files'Microsoft 5QL Server‘M55QL12.ION“MS5QL"DATA

SET PMEPath=C:“Program Files (x86)%5chneider Electric‘Power Monitoring Expert

After the above batch file is executed, close the prompt window. An Applic-
ationModules.sql fileis createdinthe .. .\SBS Upgrade Package.

4. Before running the ApplicationModules. sql file, enable the SQLCMD mode:
a. InSQL Server Management Studio click Tools > Options > Query

Execution > SQL Server > General.

b. Select By default, open new queries in SQLCMD mode, then click
OK.
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b Environment Specify the maximum number of rows to return before the server stops processing
I Source Contral WOUF query.
e seTRowcouNT: P ]
4 Query Execution
4 S0L Server Specify the maximum size of text and ntext data returned frem a SELECT statement.
SET TEXTSIZE: 2147483647 E bytes
Advanced
ANSI An execution time-out of 0 indicates an unlimited wait (no time-out).
b Analysis Server Execution time-out: seconds
I Query Results
I- Designers Specify a word or character that can be used to separate batches.
I+ SOL Server Alu_raysOn T
I» SCL Server Object Explorer
[w] By default, open new queries in SOLCMD mode
Reset to Default

oK | | Cancel |

5. In SQL Server Management Studio open the ApplicationModules. sql file and

then click Execute to run the script.

6. Afterrunning the ApplicationModules.sql file, disable the SQLCMD mode:

a. InSQL Server Management Studio click Tools > Options > Query

Execution > SQL Server > General.

b. Uncheck By default, open new queries in SQLCMD mode, then
click OK.

7. Update the DataSourceSignature:
a. In SQL Management Studio, go to the Applic-

ationModules.DataSourceBus.DataSource table.
b. Right-click the table and select top 1000 rows.

c. Copy the Signature by right-clicking and selecting Copy.
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P S @ A Newuey (BB % a9 - - E-2 ] b ltllw[

3 e ] ¥ Bcute b Debug ® v 33 3 2| 7RO 2|

Object Explorer Ll SOLQuery3.sql - ST...ON.master (sa (51)) X

Connect~ L’_Q L’_E | T 5 Jj****%% Seript for SelectTopNRows command from SSMS  ¥****x/
Dashboard. Slideshow ~ E||SELECT -Egz ::SPE[])ataSourceId]
Dashboard.SlideshowDashboard el g. e - —a
DataSourceBus.DataSource W% ~|<
DataSourceBus.DataSourceDevice [ Resutts | [13 Messages
DataSourceBus.DataSourceTopic DataSourceld  Signature LogicalDataSourceld  DataSourceTy
DataSourceBus.DataSourceType 1 1 { HIBe 508 bfab A8 T T Ep 1-GEA~ A1 AACE § N 1
DataSourceBus.DataSourcelnit ; 53 Copy Chrl+C
DataSourceBus.LogicalDevice opy with Headers Chrl+ Shifts C
DataSourceBus.MappingsQverride

- - Select All Ctrl+A

DataSourceBus.Sampledvailability
DataSourceBus.S5tream Save Results As...
DataStore.DataRow B Page Setup...
DataStore.DataRowReference Q . —
DataStore.DependencyRow = fint... s

8. Inatexteditoropen..\Schneider Electric\Power Monitoring Exper-
t\Applications\bin\DataServicesHost.config andthen update the

DataSourceSignature value to match the one you copied in the image above.

File Edit Format View Help

<?xml version="1.8"2> ~
<configuration>
<appSettings»
<add key="ServiceHostId" walue=""/>
<add key="Role" wvalue="DataBus,IonEnterpriseDataSourcelriver,Hierarchy"/>
<add key="DataSourceDriverInstance” wvalue="I0ON Enterprise-Default™ />
<add key="DataSourceSignature" wvalue="GRETET5H o E b W Ss o T8 o0 B T ST et 15751
</appSettings>
</configuration>

" s

Note: Once the upgrade is complete, it is recommended that you make a backup of
the upgraded databases. Should your database become corrupted at a later time, this
backup of the upgraded databases will help you to complete the upgrade suc-
cessfully. A suggested location for these backups is ..\Schneider Elec-
tric\Power Monitoring Expert\config\cfg\DBBackups.

Update Server Name

Note: These steps are required only if the new server name is different from the old
one. If the names are the same, you can skip this section.
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Some applications in PME reference the name of the computer where the system resides.
Since the old name is embedded in the databases and configuration files of the old system, it
is transferred to the new system with this configuration. If the name of the new computer or
server is different from the old one, there is a mismatch.

The topics in this section describe how to remove this mismatch by updating the name stored
in the configuration to the new computer or server name.

Distributed System Note: Unless otherwise noted, complete these steps on the
Primary Server.

Locate and Note Server Name in Management Console

You will need to reference the new server name in subsequent tasks.

To find the name of the computer the PME 8.1 server is running on:

1. InWindows Server 2012 or later, right-click the Windows Start button and then
select System.

The computer name is displayed in the System dialog:

il System -Flm
() [ vt @l =
Tasks @

Yiew basic information about your compuber
&Y Device Manager « acltion

i) Remoke setting: Windaws Server® Stardard

¥ Advarced system settings Capyright & 2007 Microsoft Corporation. All rights ressrved,
Service Pack 2
——)
System
Processor: Tritel(R) Xeandrt) CPU WSE75 @ 3.07GHz 3.07 GHz (2 processors)
Memory (RAM): 4,00 58
Systen Lype: Ed-bilt Oy aking System
Computer name, domain, and workgroup settings
Computer name: PMEServer d:: ifchange settings
Full compiter name: PMEServer
Computer deseription:
We'orkgroup: WORKGROUP

2. Note the computer name; you will need to reference it later.

To find the old server name that is currently configured in the transferred configuration:

1. Login to the Management Console using the old system login credentials.
2. View the Servers panel.
For example:
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File Edit Yiew Tools

Help

o)

Drag a column header here to group by that colum

| Enabled

Marme

Description

Note: Since the ION_Network database is now accessible, the Man-
agement Console can be opened.

3. Note the existing server name. You will need to reference it later.

Update Server Name in the Databases

Distributed System Note: Complete these steps on the Database Server.

To update the server name in the ION_Data and ION_Network databases:

1. Open SQL Server Management Studio, select File > Open File, then select the

update server name in live databases.sql scriptinthe ...\SBS

Upgrade Package\SQL Script Files folder.

© 2016 Schneider Electric. Allrights reserved.
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Edit the script to provide the old and new server names and the instance name.

DECLARE @0ldName nvarchar (100)
DECLARE @newName nwvarchar (100)
DECLARE @CldsglServerMame nvarchar (100)
DECLARE @NewsglServerName nvarchar (100)

—— Replace the variables <OLD PME_SERVERNAME> and <NEW_FME_SERVERNAME>» below with the actual names of the old
and new PME server.

—— Use all upper-case letters for the names. Do not remove the single guotes "™ ' ", Example: SET GoldName =
"PFMESERVER' .

—— NOTE: This is the PME server name for both standalone and distributed systems. It is NOT the DB server name.

SET @oldName
SET @newName

'<OLD_EME_
'<NEW_EME__

W

—-- Replace the variables <OLD 5QL SERVERNAME AND INSTRNCE> and <NEW_SQL_ SERVERNAME AND TINSTANCE> below with the
actual names of the old and new 5QL server and instance.

—— U=e all upper-case letters for the names. Do not remove the single quotes " ' ", Example: SET
@0ldsglServerlame = 'server=FMESERVERWION'.

—— If you are using a default 5QL instance do not add \ instance name

—— NCTIE: For standalone PME systems the S5QL server name is the same as the PME server name. For distributed FME

systems, the 3QL server name i=s the name of the DB server.

SET @0ldszglServerName
SET @NewsglServerName

Save the script and then click |Execute to update the server name in the databases.

Verify that the script worked by looking in ION_Data.dbo.Source table. The

LOGINSERTER source should now show the new server name.

Note: For any archived databases, complete steps 1 to 3 above, but use the
update server name in archive databases.sql scriptinstead. Repeat
these steps for each archived database.

Update Server Name for the VIP

When PME s installed, a factory default VIP is created. The configuration files and folder for
this VIP contain references to the server name. You need to replace the VIP that was created
during the new PME installation with the VIP from the old PME system. This only addresses
the default VIP. Custom VIPs are addressed in a subsequent step.

Note: Do not modify the VIP. PQADVISOR. This is a new VIP that was introduced
in PME 8.1.

To update the server name for the VIP:

Find the old and new VIP folders in..\Schneider Electric\Power Mon-

itoring Expert\config\cfg\vip.
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Home Share View
{{__-} = 1| .« config » cfg » vip » VIP.NEWSERVER
W ss ~ Mame
40 vip

vip.bak
| @l | VIP.NEWSERVER — e

vip.cf
.. VIP.OLDSERVER. e
.. Diagnostic

2. Copy vip.bakandvip.cfg fromthe old VIP folder (VIP.OLDSERVER in the
example) into the new one (VIP.NEWSERVER in the example), overwriting the
files, and then delete the old folder.

This transfers the configuration of the default VIP from the old system into the new
PME system.

3. Find the node diagram forthe VIP in..\Schneider Electric\Power Mon-
itoring Expert\config\diagrams\nd, delete the new node diagram, if one
exists, and rename the old one to match the new server name. Not every system

will have this \nd configured with the VIP.

4. |If they exist, delete all the VIP tree files, new and old, in ..\ Schneider Elec-

tric\Power Monitoring Expert\config\trees.

| 1. <« Power Monitoring Expert » config » trees » v O | | Search trees
rence Assemblies ~1 Mame - Date modified Type
1eider Electric )
o L temp 5/14/2015 T:34 PM File folder
wer Menitoring Expert . .
: || LOGINSERTER.NEWSERVER 51472015 4:25PM  NEWSERVER File
zonfi N
: : || LOGINSERTER.OLDSERVER 10/31/2013 2:22 PM  OLDSERVER File
S || QUERYSERVER.NEWSERVER 5/14/20154:25 PM  NEWSERVER File
istall Information " :
. || QUERYSERVER.OLDSERVER 4/22/2015 3:41 AM OLDSERVER File
dows Mail W .
) vipNewserver - 5/14/20154:25PM  NEWSERVER File
dows NT | | VIP.OLDSERVER h 4/22/2015 3:41 AM OLDSERVER Fil
- o I ) e
dowsPowerShell _

Update Server Name for other Components

The names for files related to the Diagnostics and the Designer node diagrams need to be
updated.

Note: The \nd folder will not be on your system if it has not been configured. Skip
this step if nothing is there.
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Distributed System Note: Complete these steps on the Primary Server and on the
Database Server (for those files that exist on the DB server).

To update the server name for other components:

1. Delete the old server Diagnostics Configuration file in ..\Schneider Elec-

tric\Power Monitoring Expert\config\Diagnostic\.

Home Share Wiew
@ - 4 | . « Power Monitoring Expert » config » Diagnostic
.. AlertMonitor ~ Mame -
I cfg
- - | pminetman.NEWSERVER.dbg
I| . Diagnostic |
: | pminetman.OLDSERVER.dbg
I . diagrams
I || exporters \

2. Rename or delete the old Query Server and Log Inserter Designer files if any are

presentin..\Schneider Electric\Power Monitoring Exper-

t\config\diagrams\nd\. Only the new server name files are needed.

Home Share Wiew
@ + 4| ) « Power Monitoring Expert » config » diagrams » nd
j_. UPS b MName

| visio_drawings h
LOGINSERTER.OLDSERVER..cf P
B WMF_symbols - .

. | || QUERYSERVER.OLDSERVER. cfg “
| I .
- || vip.NEWSERVER.cfg

- ) ud .
& | | vip.OLDSERVER.cfg

. exporters

ko L [ SN

Update Server Name for Alert Monitor

The Alert Monitor configuration file includes the server name. If the Alert Monitor configuration
file was configured in the old system, replace the {Old Server Name} with the {New Server
Name}.

To update the Alert Monitor configuration file name:
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1. InWindows Explorer navigateto . . . \Schneider Electric\Power Mon-

itoring Expert\config\AlertMonitor.

2. Ifa{0ld Server Name}.AlertMonitor.configfile exists, rename it with the
name of the new server.(Do NOT delete the {MachineName}.Aler-

tMonitor.configtemplate.)

Home Share View

Ii(__—jl = 4| . « PowerMonitoring Expert » config » AlertMonitor
. Applications - Mame B
.. config

=8 IMachineMame}.AlertMonitor.config

1. AlertMonitor _ _
o |§ {QOLDSERVER LAlertMenitor.config
e . || AlertMonitor-5chema.ml
. Archives
L NBRarkun=s

Delete old Log Inserter and Query Server Folders

The Log Inserter and the Query Server in PME store configuration information in folders and
files that reference the existing system's server name. These folders and files must be
deleted for the old configurations.

Note: A backup file might be present depending on the customizations done to the
Log Inserter or Query Server. If there is a customized Log Inserter or Query Server,
consult Technical Support for instructions on how to migrate them to the new sys-
tem.

To delete the old configuration files:

1. Navigate to the Log Inserter and Query Server configuration folders in ..\ Sch-

neider Electric\Power Monitoring Expert\config\cfg\logsrv.
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2. Delete the older server folders.

LA logsrv
Home Share Wiew
i(—) * T | . « Power Monitoring Expert » config » cfg » logsre »
. Archives -~ Mame -
. DBBackups
. LOGIMNSERTER.MEWSERVER
, DbScheduledTasks
I . LOGIMNSERTER.OLDSERVER
o . QUERYSERVER.MEWSERVER
= . QUERYSERVER.OLDSERVER

AR

Register Custom VIPs

If the old PME system contained custom VIPs, then you need to register them in the new sys-
tem before they can be used. The configuration folders and files for these VIPs were trans-
ferred as part of the \config folder transfer.

Distributed System Note: Complete the following steps on the Primary Server.

To determine if there are custom VIPs:

1. Navigateto..\Schneider Electric\Power Monitoring Exper-
t\config\cfg\vip

If there are custom VIPs in this folder, they need to be registered on the new sys-
tem.

To register custom VIPs:

1. Open a command prompt as the Administrator.

2. Changetothe.. \Schneider Electric\Power Monitoring Exper-

t\system\bin folder.
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o1 Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.96081
{c)» 2013 Microsoft Corporation. All rights reserved.

sWindowsssystem32 reds

:_\)ccl C:sProgram Files {(x86>\8chneider Electric“Power Monitoring Expertssystem®
in

:wProgram Files (xB6>“Schneider Electric“Power Monitoring Expertssystemvhiniuip
.exe —Service —HUIP2

:SProgram Files (xB6>“Schneider Electric“Power Monitoring ExpertssystemsbinX_

3. Runvip.exe -Service -N<custom VIP name>.

The new service is added for the custom VIP.

Services |:
File Action View Help
e EHd= BE » o0 p
Services (Local) Services (Local)
ION Virtual Processor Service - Name - Description  Status Startup Type  Log OnAs
NVIP2 ION Site Service Manages in... Automatic Local Syste...
) ION Software Alarm Service Performs al... Automatic Local Syste...
Start the service ION Software Modbus Gateway Service Enables soft... Manual Local Syste...
ION Virtual Processor Service Provides ag... Automatic Local Syste...
Description:
Provides aggregation, contrel, and ION XML Subscription Service Processes X... Automatic Local Syste...
mathematical analysis of power ION XML Subscription Store Service Stares subs... Automatic Local Syste..

menitoring system data

Note: The VIP name service registration is case sensitive; make sure you spell it
exactly as it was in the old PME system.

Install the Report Subscriptions

Installing the report subscriptions depends on the SQL Server Editions used by the old and
new systems:

SQL Standard SQL Standard Use the SBS Upgrade Package tool (see
instructions below)

SQL Express SQL Standard Use the SBS Upgrade Package tool (see
instructions below)

SQL Standard SQL Express Subscriptions must be recreated in PME 8.1
(skip this topic)

SQL Express SQL Express Subscriptions are automatically transferred
with the ION_Network database migration
(skip this topic)
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Distributed System Note: Complete these steps on the Primary Server.

To install the Report Subscriptions:

1. Navigateto..\Schneider Electric\Power Monitoring Exper-

t\system\bin folder and then run TmportSubscriptions.exe.

2. Inthe dialog box that opens, make sure the file pathis ..\Schneider Elec-
tric\Power Monitoring Exper-

t\system\bin\IONSubscriptionData.xml:

ImportSubscriptions E

IC:\F'rogram FileshSchheider Electrichl DM Enterprizehaystemnbinh OM S ubscriptionl Browse I

Import Subscriptions |

3. Click Import Subscriptions.

When the import is complete, a Successfully Imported Subscriptions dialog is dis-
played.

Update SQL Server Logins

To update the SQL Server logins:

1. In SQL Server Management Studio, navigatetothe . . . \SBS Upgrade Pack-

age\SQL Script Files folder.
2. Using atext editor, open Fix PME Users.sqgl.

3. Replace <NEW PME SERVERNAME> with the name of the server on the new sys-

tem:
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-- Deletes and re-adds the ICNMaintenance account in master, ION Network, ION_Data, ApplicationModules, ICN_SystemLog.
-- Fixes the jgpedsd user in ION Data and ION Network.

-— Fixes EMUser in ApplicationModules.

-— Fixes the ENM user for segment editions

-— Removes the ICN user with DBO role membership and assigns it as the DBO.

-- NOTE{_Replace <NEW_PME_SERVERNAME>JWith the name of the PME server. T.’]EIEUf thisg in the script that need to be replaced. Us
upper-case leCLE -t =T name.

-- Example: DROP LOGIN [PMESERVER\ICHMaintenance]

USE [master]
IF EXISTS (SELECT * FROM sys.syslogins WHERE name — N'<NEW_EM
DROP LOGIN [<NEW PME SERVERNAME>\IONMaintenance] ﬁ

NAME >\ IONMaintenance')

USE [ICH_ SystemLog]

IF EXISTS (SELECT * FROM sys.database principals WHERE name = N'IONMaintenance')
DROP USER [IONMaintenance]

USE ICH Network

ALTER USER ionedsd WITH LOGIN = ionedsd

IF EXISTS (SELECT * FROM sys.database principals WHERE name = N'IONMaintenance')
DROP USER [IONMaintenance]

EXEC sp change_users_login "AZuto Fix"', 'ENM'

USE ICH Data

ALTER USER ionedsd WITH LOGIN = ionedsd

IF EXISTS (SELECT * FROM svs.database principals WHERE name = N'IONMaintenance')
DROP USER [IONMaintenance]

EXEC sp_change_users_login 'RZuco Fix®, 'ENM'

USE ApplicationModules

ALTER USER AMUser WITH LOGIN = AMUser

IF EXISTS (SELECT * FROM sys.database_principals WHERE name = N'IONMaintenance')
DROP USER [IONMaintenance]

-— Recreate IONMaintenance login and DB users

USE [master]

CREATE LOGIN [Q\IEW_PHE_SERVERNAHE>\IONMaintEnancE] FROM WINDOWS WITH DEFAULT_ DATABASE=[master]

TIER  [Mrml s matinnMadslasl

4. Save the script file and then execute it.

Update SQL Server name for PQDIF reports

For server configurations that contain PQDIF Reports in Reporter:

1. Find and edit the PQDIFExporterConfig.xml configuration fileinthe ..\ Sch-
neider Electric\Power Monitoring Exper-

t\config\exporters\PQDIF\config folder.

2. Update the SQLServer Name and Password. The SQLServer name should match the

new server name, and the password should match that of the RepGen reports; see
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"Update RepGen Report Parameters" on page 76.

20
21
22
23
24
25
2h
27
28
HE
30
3l
3z
33

T

- revigion # of the PQDIF E:

<DatabaseConnection
SoLSerwver=""
DatabR=""
NetwoarkDE=""
SyvstemLoghB=""
USE:L-=II n
Password=""
Timeout="&0"
CortnandTimecut="180"
A
< !—— DatabhaseConnection

- SoL3erwver — the 0L !

Note: If there is nothing configured for PQDIF then these values will be blank (*”).

Reconfigure PME 8.1

The PME 8.1 Installer is used to upgrade additional configuration files. Access to the PME
8.1 Install medium (DVD or .isofile) is required for this step.

Note: Upon completion of the steps below, the “supervisor’ account password is
reset to the password that was specified when PME 8.1 was first installed. It will not
be the same as it was on the old PME system. Use the User Manager application
that is accessed via the Management Console to change the password if needed.

Distributed System Note: Complete the following steps on the Database Server
first, and then on the Primary Server.

To update the configuration files:

1.

Close any PME programs that may be running.

2. Change the ION Log Inserter service back to Automatic. It was previously disabled.

3. Runthe PME 8.1 installer orthe MainSetup.exe.
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4. Choose Configure to upgrade the configuration.

Schneider

StruxureWare Power Monitoring Expert
8.0 Installer

The application is currently installed on this system.

| Cheose this optien to re-configure the

I Configure product.

I Remove | Choose this optien to remove the product.

I Cancel |

5. Once the configuration is successfully complete, click Next to complete the recon-

figuration.

Note: The PME Installer will start all necessary ION Services as part of the con-
figuration upgrade. Any Custom VIP service configured must be started manually.
Start the ION Services using the administrative credentials.

Install Custom Web Report Packs

In an earlier step, the PME 8.1 compatible custom web report packs were copied into ..\ Sch-
neider Electric\Power Monitoring Expert\Web\ReportPacks onthe new
PME system. They need to be installed on the new system.

Distributed System Note: Complete the following steps on the Primary Server.

Toinstall the report packs:

1. The Report Pack should be available in the Reports application. If not, then open
Web Applications > Reports. In the Report Library section in the right pane, use
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the tools provided to upload the report pack.

Lo (| B hetpvenamzezstd iveb R O = C || [ Bower Monitoring Expert

Q supervisor | Logout | Seftings |

DASHBOARDS DIAGRAMS TABLES TRENDS ALARMS BEisgei

Report Library
+ H O R S e<a=
'+ |3 Billing and Allocation

No report selected. Please choose one from the report library. :

[+ [[2) Campus Reports
I3 Default Reports
'+ |3 Energy Analysis
(+| |23 Energy Management
+| 23 Equipment Performance
4| I5) General
[ ) Power Quality
L | <] 1= Summary Reports
(+| |23 Usage Trending

Note: The reports list in the Report Library may be empty until the custom
reports have been installed.

2. Select the report packs to install and then click Install.

For example:
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System Reboot

Report Pack Install

Select a report pack to install:

Branch CIrCUit POWET REpOTts 3772016 3:53:18 PM Installed
BreakerAgingReports 3/1/2016 3:56:22 PM Installed ~
Default Reports 3/1/2016 3:48:06 PM Installed

Energy Management Reports 3/1/2016 3:55:58 PM Installed

Energy Reports 3/1/2016 3:49:15 PM Installed .
EPS5_CoreReports 3/1/2016 3:53:48 PM Installed
EPS5_TestReport 3/1/2016 3:54:11 PM Installed
EPS5_UPS_AutoTestReport 3/1/2016 3:54:34 PM Installed

Generator Power Reports 3/1/2016 3:55:14 PM Installed

Power Losses Reports 3/1/2016 3:52:43 PM Installed
PowerQualityAdvisor 3/1/2016 3:51:55 PM Installed

PUE Reports 3/1/2016 3:52:26 PM Installed
RegressionReports 3/1/2016 3:55:38 PM Installed
StandardPowerQuality Reports 3/1/2016 3:50:29 PM Installed

Summary Reports for RS2008 9/24/2015 11:19:10 AM

UPS Power Reports 3/1/2016 3:54:54 PM Installed

Usage Reports 3/1/2016 3:51:26 PM Installed v
Xpert Trending Analysis Rep... 3/1/2016 3:49:25 PM Installed

‘ ‘ Close

At this point in the upgrade process, many configuration changes are complete, and it is

recommended that you reboot the system.
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Step 6 — Configure the Individually Transferred Settings

These steps adjust those settings and configuration items that are not part of the
SBS Upgrade Package transfer.

Scheduled Tasks

PME 8.1 uses Microsoft Windows Task Scheduler to schedule database maintenance jobs
such as archiving or backup. Details of the default PME database maintenance jobs are
defined in a number of PowerShell scripts.

Compare the default settings on the new system to the ones noted from the old system.
Decide which settings should apply to the new system and encode them into these script
files.

File Adtion  View Help
«« 2(m BE
@Trmh:muﬂuw N St Triggen Mot Run Tame =] | Rethons
El e'l'!-l;*&hm.;t-l-hrw (B |Apphcaticntadidet] - BACKUR - Job Ready A 1I0AM mvery diy w0610, | | Power Monitori. =~
b= 00l
2 1 Sehoasdar Elechric (& |Applicationiaodider] - MAINTEMANCE - Job Ready 22 T:30AM everydry i.flﬂ'iuli}-‘:nm.. T Create Busic Ta.-
e B ApphicstionMaduler] - TRIM - Job Ready A2 TI0AM every duy TG0 3000, % Create Taik
) . - BRCHNE - Iob Disabled A2 1 an day § of | ; ek Tak
- every Fridmy - z Iregegrt Task.
A Displey Al Ru..
Seraral l [ J_ I - [§] Enalste Al Task...
enersl | Triggers | Actions | Conditions | Seftings | Hi (i absled)
— L] = 7] | B M Folder... I
Hame:  [[I0H_Data] - BACKUP - kb 120 | 3¢ petets Fotder
Logation:  Vickeweider Electric\Power BMonitoning Expert Voo '
Bathar: Adrramsirates = G Refesh
Dezcription: B
b R ]
™ End
Teriricpeptions & Dizable
Whar nansien Hhe fark sims tha fnllossinn s s o hd [ -

To review the PowerShell script settings:

1. In Windows Explorer navigate to ..\ con-

fig\cfg\DbScheduledTasks\Support andopen Configuration.psl.
2. Note the setting values for:

» SlocationForBackupFiles

» $locationForArchiveDBFiles

” SarchiveDBDaysToKeep

» SmaximumDatabaseSizeInGigabytes

» SdatabaseSizeNotificationThresholdPercentage

» SdiagnosticsDaysToKeep
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3. Navigateto..\config\cfg\DbScheduledTasks\ and open Backup.psl.

4. Note the setting values for:

» SnumberOfBackupsToRetain

5. Compare these settings to the ones noted from the old system. Decide which set-
tings should apply to the new system and encode them into these script files. If in

doubt, use the default settings on the new system.

Vista Diagram Links

Because the Query Server name includes the computer name, which has changed from the
old system to the new, any Vista diagrams that use Custom Query Server links must be
updated. Updating the Custom Query Server links can be done manually by opening the dia-
gram and changing the Query Server link of the diagram background.

If inheritance is used in the Vista diagram, then only the top most diagram needs to have its
Query Server link updated. The update filters down into any linked diagrams.

Wéindow Properties Configuration
.Image Query Server |N|:u:|e ] Action | pdates |

" Inkerit from parent icaon Cancel

(& Custom Cluery Server

Edit Lirk...

Group.Name: QUERYSERVER PMESERVER <=

Register:Gk1 Query Reagister

However, for a large number of diagrams, use a search and replace tool that can find the
Query Server strings in the diagram files and update them to the new server name.
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Note: Search for the Query Server string settings where the use parent link option
is set to 0. There are many server references in each Vista diagram that have a use
parent link set to 1; you can ignore these.

Nj TI50_FAC-4WYE W1.3.1-pg.dgm - Motepad
File Edit Format View Help

(=]

</TexTIcons
</Icans
<fchildrens

<Fontspec color="#000000" log_font_height="-11" Tlog_font_width="0" Tog_font_escapement="0

<maxuniguelds1</Mmaxuniguerds
<offsets
<Left=0< Lefts
<Top>0</Top>
«/offsets
<Dimensions:>
<width>996< Width>
<Height>635</Height>
</Dimensions>

-

Tog

<Location left="3512" top="0" bottom="5%31" right="1478">< Location>

<windowsetting>3< windowsetting>
<Unigueld:-l</0niqueld>
</IonPanex
<ModeLink use_parent_Tlink="1">
</ModeLink:>
<LogServer use_parent_Tlog server="0">
<Node>QUERYSERVER. PMESERVER </Node> <=l
<Handle»>327952</Handlex>
</LD?Server>
<stalePeriod=60</stalereriods>
<UpdatePeriod_s»>2</Updatereriod_s>

<Backgr0und1ma?e>x—pm1:/dﬁagrams/images/lcons/ION_Logo.bmp</Eackgr0undImage>

<Clineopens</CTinecpens
<ClinecCloses</ClineClosex
< UserbiagramPaneas>
</Tonbiagrams
< useroiagraminfos
</PMLDT agr am:

4 1

The same is true for any links in the diagrams (for example, a numeric value) to the VIP(s)
that were migrated from the old system to the new. The name of the VIP might reference the
computer name, and if this name has changed, then the links to the VIPs must be updated.

If you encounter issues, see "Device Diagram Customizations" on page 97 in the

Troubleshooting section.

OPC Measurement Definitions

Update the DefaultMeasurements.xml file with the changes identified in "OPC Meas-

urement Definitions" on page 32.

tomizations.

Note: If you simply copy the old file into the new system, you overwrite any new addi-
tions to the file that are part of the new PME system. This might be acceptable or not,
depending on if you need the device types and measurements that have been added.
In general, it is a better practice to keep the new file and manually add any cus-

Web Report Subscription Parameters

Since the system was moved from one computer to another, it is possible that file paths that
were previously configured for saving reports as part of a subscription need to be changed.

To update these file paths:
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1. Open the Manage Reports in the Reports Web Application.

e N http://en2012r2std Aeb/4Re O ~ & E Power Monitoring Expert x

DASHBOARDS DIAGRAMS

Q supervisor | Logout | Setftings | He

TABLES TRENDS ALARMS [QEiSgeligs

Mo report selected. Please choose one from the report library.

2. Click Subscribe and then Modify.

P

Report Library
+ EHERS
|4l 3 Billing anaﬁlocatian
[#| |2) Campus Reports

~

|=2) Default Reports
[#] |22 Energy Analysis
[#| |2 Energy Management
[#| [2) Equipment Performance
[+ 3 General
[+l 3 Power Quality
[#] |Z2) Summary Reports
[#| |2 Usage Trending

Manage Reports

O Manage O share ® Subscribe
T— =T = L
System Configuration Report
HD Equipment Performance ~ b 9 P
Name Description | Jwner
[+l 23 General System config report Run daily at 12:00 AM SUpErvisor

1+l 3 Generator Performance
[+l 3 Power Capacity

[+l 3 Power Efficiency

[+l 3 Power Quality

%] =2 Power Quality Advisor
1=I 3 Subgribed Reports

System Configuration Report

[+] 2 UPS Performance

Delata
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3. Select the File share option and enter the Report destination path.

Add New Subscription

Name:

System config report

Output Format:
® Excel O Tiff O PDF (Letter) O HTML O XML
Delivery Mode:
O E-mail ® File share () printer
Report destination (i.e. C:\Reports\ or VWWComputer\Share\)
|\\semer\Report.s ‘___ |

[ overwrite existing file \

Subscription Schedule:

Conalarm O onee O Hourly ® Daily 'i::'Weekly ':::'Monthly

Time of Day: [12:00 am

Save

Cancel

Note: The Windows IONUser account needs write permission to the folder
where the report is being delivered.

4. Click Save.

Update RepGen Report Parameters

Update the server name in the report .xIs files.

To update the server name in the Excel report workbooks:

itoring Expert\config\reports folder.

Right-click any tab and then unhide the | PRIVATE | Datasheets.

Open a report workbook from the ..\ Schneider Electric\Power Mon-

Update the server name on the far right end of the entries in this sheet to the new

server name. Repeat this step for all the Excel reports in the Reports directory.
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If a report is configured to be saved to disk (instead of shown on screen only), you need to
update the report and re-save it in the new PME location before you generate any saved

reports.

To update a report:

1.

Registry Settings

Open Reporter and click the radio button for Manage Reports.

Highlight a report and click Edit.

Click the Distribution tab.

Verify that the Save Excel report folder path is correct or create a new one.
Click OK.

Click the radio button for Generate Reports and then generate the report to verify it

is working properly.

Editing the registry entries in the new PME system is necessary if you want to:

? Specify a custom network diagram (instead of using the default network diagram) to

be used in the Diagrams (WebReach) part of the Web Applications.

?* Enable linking of custom device types (for example, those created with the MDI) to

default diagrams in ION Vista.

Do NOT import any performance tuning settings from the old ION Enterprise. The default set-
tings in PME 8.1 have been optimized for that system and should only be changed by experts
with a deep understanding of the ramifications of the changes.

To customize the network diagram:

1.

Start the Windows Registry Editor and browse to:

HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\Schneider Elec-
tric\Power Monitoring Expert\8.1\WebReach [For64-bit systems]

HKEY LOCAL MACHINE\SOFTWARE\Schneider Electric\Power Mon-
itoring Expert\8.1\WebReach [For32-bit systems]

Right-click to Add a new string value of NetworkDiagram.

Right-click NetworkDiagram, select Modify, and type the path and name of your

custom network diagram in the Value data field.
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Forexample: x-pml:/diagrams/ud/<custom folder>/<custom dia-
gram>.dgm.

4. Restart IS on the system to apply the changes.

Shortcut Tools | Application Toals

Haome Share Wi Manage Manage

T « Al Control Panel lterms » Administrative Tools v & | | Search Adrministrative Tools

FY

S Favorites Marme Date modified Type Size

B Desktop 1 Terminal Services B/22/2013 &304 File folder
& Downloads @- Caomponent Services B2ZMITLETPM Shortcut
“El Recent places @Computer Managerment 82172031154 P Shortcut
(gl Defragment and Optimnize Drives B2 2M3ITTAT P Shortcut
1M This PC @ Event Wiewer BA1/2013 1155 P Shorteout
i Desktop El Internet Information Services (I5) 6.0 Ma., 22120121150 PM Shortout
ﬂ Documents |% Internet Information Services (IS} Manager 82172013 1150 PR Ehortcut
& Downloads Bl iSC3 Initiatar 2203157 P Shorkout
o Music @ Local Security Policy 82172031154 P Shortout
= Pictures 2 Microsoft Azure Services H2MA %02 PM Shortout
& Videos ODBC Data Sources (32-bit) 8212013 K56 P Shortcut
i Local Disk (G, il :

16 iterms 1itern selected 1.10KE

To enable the diagram linking in Vista:

1. Start the Windows Registry Editor and browse to:

HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\Schneider Elec-
tric\Power Monitoring Expert\8.1\DeviceInfo [For64-bit systems]

HKEY LOCAL MACHINE\SOFTWARE\Schneider Electric\Power Mon-
itoring Expert\8.1\DeviceInfo [For32-bit systems]

2. Add the necessary entries for the custom device types.

ION Login Password

The Modify Login action in the Database Manager tool changes the SQL Server password for
the default login name ION. If the password was changed on the old system, it needs to be
manually changed to the same string on the new system in the PME Database Manager.

To change the password:
1. Stop all PME services.

2. From the Management Console start Database Manager.

3. Right-click Databases then select Modify Login to open the Modify Login dialog.
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4. Type the new password in the New Password and Confirm New Password fields.

Click OK.

5. Restart the services.

Clear Browser Cache

Following an upgrade, it is recommended that you:

1. Delete the browser cache.

This will clear any old configurations or cached pages that might have been on the
system before the upgrade. If you are unsure about how to do this, an Internet
search can help you find out how to delete the cache on every supported browser.

2. Re-run saved Web reports and re-save them.

This ensures that the reports can be read correctly on the new system.

Upgrade Custom Device Drivers

Some LE device drivers (drivers that were downloaded) from the old PME system may have
become Standard Edition (SE) drivers (i.e. default drivers) in PME 8.1. In such cases there
will be two entries in the device type list for the same type.

You can see these device type entries in the Management Console: one is an LE type carried
over from the earlier version; the other is the SE version that was installed during upgrade.

Iretns in rad are mandstoy

Grciip

Hame:

Device Type fesyeT i
TCR(IP Address TedysT

ceps SER 3200

Enabled cEr 2408

Desaription FHBLOLE

Manually changing the device type can unlink previously logged data. Therefore, an upgrade
to SE should be performed.

To upgrade the driver:

1. In Management Console right-click on the device instance to be upgraded, and
select Upgrade LE Device.

A warning message is displayed asking to confirm that it is okay to stop and restart
PME Services.

2. Click OK if this is acceptable.

Clicking OK executes the device upgrade. A message is displayed when the
upgrade is finished.
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After you close the Upgrade status window, the device type of the instance will change.

For example from TeSysT to TeSys T:

W |SER3200 |SER SER 3200 10.
v ]m-m Tesys Ty T 10,
v |McrologicH Micrologic | Microkogic H 10,

This procedure applies to both CE and LE drivers listed below. The list of drivers that need to
be upgraded in PME 8.1 include:

Altivar 61 CE CE CE Native |Yes

CM100-200 CE CE and SE Installer |CE and SE Installer |Native  |Yes

EM3460 LE Native |Yes

Enercept CE CE CE and SE Installer |Native |Yes

PM5300, 5100, 5500 |PM5000 series LE | Native Native Mative [No
*due to
Register
Pruning

PM600 CE and LE CE and Native® CE and Native* Native |Yes issues

TeSysT CE CE CE and SE Installer |Native |Yes

Varlogic NRC12 CE CE and SE Installer |CE and SE Installer |Native |Yes

This may not be the complete list for all version upgrade paths.

Note: Any missing LE Drivers should be downloaded from the Schneider Electric
Exchange and Installed separately. Make sure you download PME 8.1 versions.

EcoStruxure Web Services Configurations

The EcoStruxure Web Services (EWS) service is disabled when PME is initially installed. If
EWS was enabled on the old system, it must be manually enabled on the new server and
updated with the values from the old system.

To enable EWS, update the EWS settings from the old system, and copy the extensions
folder:

1. InWindows Explorer navigate to..\Schneider Electric\Power Mon-

itoring Expert\Applications\EWS\ andthenopeniWeb.config.
2. Search for the following string: key="EWSEnabled".

3. Changeits valueto 1.
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4. Update the following Web . config values to be the same that they were on the old

system:
»

»
»
»

»

EWSAlarmSortOrder
ContainerItemStructure
DisplayNanValue
ConcatSourceAlarmEventId

RealTimeRefreshRate

5. Copy the files from the old Extensions folder— .. .\SBS Upgrade Pack-

age\EWS —tothenew one: .. .\Schneider Electric\Power Monitoring

Expert\system\WebServices\Extensions

exists.

Note: There is already an Extensions folder in this location in the new
system. Do NOT overwrite files in the target folder in case a file already

6. Open Management Console.

7. Select Tools > System > Update EWS Server.

File  Edit

Wiew | Toals | Help

@

Semers

&

Devices

System

Database Manager

User Manager
Beporting Configuration
Logical Device
Hierarchy Manager
Rate Editor

Alarrn Configuration
Deactivate Alarms
Configure MManaged Circuits
Dptions

b

b

Designer

Diagrostics Wiewer

Device Upgrader

todbus Dewvice rmporter
Rermote Modem Setup

[OM Wirtwal Processor Setup
Update OPC Sercer

Update EWAS Server -:::
PODIF Exporter

Time of Use Editar

|

B0 R I B R ||
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Step 7 — Perform a Post-upgrade System Check

Verify that the PME 8.1 system is configured correctly. Use the checklist below to do a sys-
tem walk through. For each item in the checklist, make sure the system behaves the way you
expect.

For example:

»» s all the information present?
*» Are measurements being displayed and are they updating?
*» Are reports running and returning the expected data?

*» Are all devices configured and communicating?

Some of the new features in PME 8.1 need to be configured before they will provide the expec-
ted information or functions. Configuring these new features is not part of this document.
Refer to the PME 8.1 user documentation and other product resources for information on con-
figuring these features.

Checklist

To perform a system walk through on your newly upgraded system:

1. Check the system log in the Management Console for errors.
2. Check the Devices, Sites, and other settings in Management Console.

3. Check the availability of the archived databases for reporting in the Reporting Con-

figuration Manager in the Management Console.
4. Loginto Vista, verify the network diagram, real time data, and data logs.
5. Check the data and functions provided by the VIPs.
6. Log intothe Web Applications.
7. Runthe reports, Diagrams, Tables and Dashboards.
8. InWeb Reporter, run saved/custom reports and verify the report subscription.

9. Log into the Reporter (also known as RepGen) application and generate the saved

reports.
10. Check any scheduled tasks.

For maintenance, follow the standard maintenance best practices recommended for PME
8.1.
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Supplemental Information

The following PME 8.1 documents provide supplemental information to the instructions found
in this document and for the PME 8.1 software in general. The documents are available on the
Schneider Electric Exchange Web site or at www.schneider-electric.com.

?” What's New, document number 7EN12-0293.

?* Before Installing your Software, document number 7EN52-0383.
?* Using the SQL Server 2014 DVD, document number 7EN52-0391.
# |nstallation Guide, document number 7EN02-0380.

? User Guide, document number 7EN02-0379.

»* Power Monitoring Expert Design Guide, document number 7EN42-0118.

** Power Monitoring Expert Licensing Quick Start Guide

Online information available in the product includes:

» Power Monitoring Expert Help — Accessible from within installed components, such

as Management Console, Vista, and Designer.

** Alarm Configuration Help — Accessible in a browser-based help format from the

Alarm Configuration user interface.

» Hierarchy Manager Help — Accessible in a browser-based help format from the Hier-

archy Manager user interface.

? Web Applications Help — Accessible in a browser-based help format from the Web

Applications user interface.
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Default Device Drivers

Use the list of PME 7.2.2 default device drivers to determine which device drivers were cus-
tomized on the old system.

3300 Acti9Smartlink PM9OC
3710 BCPM SEPAM10
3720 CM2000 SEPAM20
3800 CM3000 SEPAM40
6200 CM4000 SEPAM48
6200 RTU COMPACTNSX_A SEPAM60
7300 COMPACTNSX E SEPAMS80
7330 DM6200 SER2408
7350 DM6300 Twido Mod PLC_WAGES D12 D28 D44
7500 EM1200 VIGILOHM
7500-RTU EM3550

7550 EM3555

7550-RTU EMA4800-08 Delta

7600 EM4800-08 Wye

7650 EM4800-12

7700 EM4800-24

8300 EM5600

8400 EM7000

8500 EnerSure BCPM

8600 iIEM3150_3250

8600C iIEM3155_3255

8650 MICROLOGIC_A

8650C Micrologic EMICROLOGIC_H

8800 MICROLOGIC P

8800C Momentum_PLC_A8 WAGES

9200 Momentum_PLC D10 WAGES

9200 RTU PM1200

9300 PM200

9330 PM3250

9340 PM3255

9350 PM5100

9360 PM5300

9500 PM5350

9500-RTU PM5350_IB_PB

9510 PM5500

9510-RTU PM600

9600 PM700

9610 PM800

9700 PM810LE
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Troubleshooting

This section includes troubleshooting procedures known as of the publication date of this doc-
ument.

ION_Network with Database Manager

Issue: When upgrading ION_Network with the Database Manager, you may see a time-out
message.

latabase Manager =

The following ermer eccurred:

X

An error occurred while executing SalPackage: *** The column [dbo]. [SRC_Source], [DateAdded] is being dropped, data loss could ocaur,
=== If this deployment is executed, changes to [dbo]. [SRC_Source] might intraduce run-time errors in [dba]. [spRPT_SelectedNodes_GetReporthodes].
=== If this deployment is executed, changes to [dbo], [SRC_Source] might introduce run-time errors in [dbo].[spRPT_SelectedNodes_GetTrendData],

=== If this deployment is executed, changes to [dbo)
=== If this deployment is executed, changes to [dbo)
=== If this deployment is executed, changes to [doo)
=== If this deployment is executed, changes to [dbo)
=== If this deployment is executed, changes to [dbo
=== If this deployment is executed, changes to [dbo)
=== If this deployment is executed, changes to [dbo
=== 1f this deployment i executed, changes to [dbo]

.[SRC_Source] might introduce run-time errors in [dba]. [spRFT_Selectedhodes_UindateDates].

.[SRC_Saurce] might intraduce run-time errors in [dba]. [spSRC_DeleteSource].

J[SRC_Source] might intraduce run-time errars in [dba]. [spSRC_Source_ArchiveRecordsFromTempTable].

[SRC_Saurce] might intraduce run-time errors in [dba].[spSRC_WeatherSource_RetrieveAffectedSounces].
[SRC_SourceCategory] might imtroduce run-time errors in [dbo], [spSRC_Source_ArchiveRecordsFromTempTable].
JudfSRE_CheckCategory] might introduce run-time errors in [dbo). [spSRC_WeatherSource_AddAffectedSource].
Judfac_GetAlTrustees] might introduce run-time errors in [dba]. [spRPT_Gethode IDsByPropertyValue].
[vwSRC_Source_Retrieve] might introduce run-time errors in [dbo] . [spSREC_WeatherSource_RetrieveleatherSources],

=== If this deployment & executed, changes to [dbo]. [spAC_IsUserInRole] might introduce run-time errors in [dbo). [spRPT _GetNodelDsByPropertyValue].

=== If this deployment is executed, changes to [dbo’
=== 1f this deployment is executed, changes to [dbo)
=== If this deployment is executed, changes to [dbo
=== If this deployment is executed, changes to [dbo

.[spAC_GetSuperuserRoleID] might introduce run-time errors in [dba]. [spRPT_GethodeIDsByPropertyValue] .

[epMNT _IsDatabaseAttached] might intraduce run-time errars n [dba] . [spMM_MeasurementMap_ArchiveRecords].

[spMNT _IsDatabaseAttachad] might intreduce run-time errors in [dbe]. [spSRC_Source_ArchiveRecords],
[5pRPT_SelectedModes_CleanupAfterReport] might intraduce run-time errors in [dbo]. [spRPT_SelectedNodes_GefTrendData].

**= Could not deploy package,
This time-out is due to a SQL configuration.

Resolution: Use the following workaround to resolve this and continue the upgrades:

?» Make sure you upgrade the ION_Data database first, before you upgrade the ION_

Network database. This usually resolves the time-out error.
?*If you still notice the time-out error, then re-run the ION_Network upgrade.

If neither of these two options resolves the issue, then you need to modify the SQL Server
Registry settings to a larger value using the Registry Editor.

Note: To change the registry setting, you must have administrative privileges.

To edit the registry:
1. Goto Start and select Run.
2. Type regedit inthe Run text box and click OK. A Registry Editor window opens.
3. Select Computer and press Ctrl+F. In the Find what text box, enter

QueryTimeOutSeconds. The Registry Editor window highlights the

QueryTimeOutSeconds registry key.
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4. Right-click the registry key and select Modify. An Edit DWORD window opens.

Note: Before you modify value Data, be sure you make a note of the
default value data.

5. Select the Hexadecimal option button, and set the Value Data to 258 (OR) select the

Decimal option button, and set the Value Data to 600.

g Registry Editor

File Edit ‘“iew Favarites Help

=] . WisualStudio ;I Mame Type | Data
= 100 Qﬂ(DeFau\t) REG_5Z {walue nok set)
. DataProject 8| LockTimeoutSeconds u REG_D'WORD 000000005 (5}
. S0LDE [ T —— REG_DWORD 0x0000003¢ (60)
“ . Database
& | vsComman Madify Binary Data. .. Edit DWORD (32-bit) ¥alue
Bl . WSTAHost T
Bl L WAR Delzte ‘Walue hame:
B |, Web Service Providers [REmEIS IGuelyTimeoutSeconds
Bl Windows
- | windows NT Yalue data Bage
Bl |, Windows Script Host $ Im ’7
[ | Metscape " Decimal
[ |, ODBC =
- | Policies
[#- . Schneider Electric Cancel |
- ) SmartBear
- | Wows432hode
i Syskem
) . Molatile Environment
KFY | Ol MArHTKE >
i i il
ComputeriHKEY_CURREMT _USERY Software\MicrosoftivisualStudiol 10.04SQLDE\Database |<= v

Once the upgrade is complete, it is recommended that you reset the registry to its original set-
ting.

The time-out error may still prevail when there is NULL in a field that does not allow NULL.
This occurs in the Name column of ION_Network.dbo.Scheduler table.

I I M achinel D I SecondzDelay I Enabled I M ame I
. BEE 3 True | NULL

To correct this:
1. Goto SQL Server Management Studio.
2. Select File > Open File.
3. Navigate to the \SBS Upgrade Package\SQL_Script_Files folder and open update
Scheduler Table.sqgl.

If a NULL value is found, the script will insert “-” in the Name column.
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‘,{. Microsoft SQL Server Management Studio |_ [O0) x|

File  Edit Wiew Project Debug Tools  Window  Community  Help

e ouery | [ |2 B 5 |0 |5 W @ [ g

1 )

| feene ) m v AE|CRBER|I=2EE
<plarer SQLQueryci.sql—STANDAL...I))"‘}" SQLQuery3, sql - STAMDAL, . 71 ] ¥ X
Connect -~ @3 & T E E =
[ UZE ION Network I—
= [ Databases - —
_I LUPDATE Scheduler SET Name = '-' WHERE Name IS NULL

= Database Snapshots
| ] ApplicationModules

| ] ToN_Data -
| _j‘ IM_Metwork | 4 | Ll_l

4 Svstem Databases J

1HHBMH

Database Manager

Issue: The upgrade of ION_Data/ION_Network does not succeed and displays a message
that the ION Data.mdf/ION Network.mdf file already exists.

Resolution: The Database Logical Name needs to be different than ION_Data or ION_Net-
work_Data, and the restore location needs tobe ...\Power Monitoring Exper-—
t\Database\Data

Issue: The database upgrade finishes successfully, but some tables in ION_Data look cor-
rupted with data missing.

Resolution: Make sure that tempdb can expand up to twice the size of the live database.

Issue: The upgrade did not succeed at the Verify Databases point due to custom meas-
urements.

Resolution: Contact customer support; no resolution is available.

Upgrading Database Error
PME 7.2.2 - Upgrade to PME 8.1 - Failed on Step: Checking Space

Issue: When trying to upgrade PME 7.2.2 to PME 8.1, the process was unsuccessful at the
Checking Space step.

The following entries may be seen in the Error Log:

System.ArgumentException: Illegal characters in path.

at System.IO.Path.CheckInvalidPathChars (String path, Boolean check-
Additional)

at System.IO.Path.NormalizePath (String path, Boolean fullCheck,
Int32 maxPathLength, Boolean expandShortPaths)

at System.IO.Path.GetFullPathInternal (String path)

at System.IO.FileInfo.Init (String fileName, Boolean checkHost)

at System.IO.FilelInfo..ctor (String fileName)

at Installer.InstallTools.ConfigureSQL.GetDBFilePhysicalPath
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(String dbName)
at Installer.InstallRequests.CheckDiskSpaceGenericRequest.DoJob ()

executeQuery (SELECT filename FROM sysdatabases WHERE name = 'ION
Data', master) Failed on exception:

\nSystem.InvalidCastException: Unable to cast object of type 'Sys-
tem.DBNull' to type 'System.String'.

at Installer.InstallTools.ConfigureSQL.ExecuteScalar (SglCommand
command, String dbName)

Cause: SQL user ION needs Sysadmin level user privileges and the SQL Server services
need to be running under the "Local System" account.

Resolution: Complete these steps:

1. Login to SQL Management Console with a Sysadmin level user.

2. In Security\Logins, double click on the ION user to bring up the Login Properties win-

dow.
3. Select Server Roles, and check sysadmin on the right side, then click OK.
4. Open Windows Services.
5. Right-click on the SQL Server service and select Properties.

6. Inthe Properties window, select the Log On tab, check Log on as Local System

account, then click OK.
7. Do this to the SQL Agent also and then restart the SQL and SQL Agent services.

8. Re-run the upgrade.

Troubleshooting Vista

Issue: The Vista diagram does not open in the Engineering Client, even after the Engineering
Client license is applied to the server.

Workaround: For the Vista diagrams to open properly, first delete the trial license from the
server, and then apply the Engineering Client license to the server.

Issue: After completing the upgrade, Vista will not run. When it is launched, you see the
splash screen, but before you get to the login screen, Vista crashes. You see a dialog from
the operating system stating that Vista has stopped working.

Cause: This happens if your PME config\cfg\ud directory has a global . logfile. G1ob-
al.logis afilethat is created when you add a Global Event Viewer to Vista. The old file
format from ION Enterprise 6.0 or earlier is not compatible with PME 8.1 Vista.

Workaround: Delete global. log. You must re-add a Global Event Viewer if you want to
use it in your upgraded system.
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Issue: You see a configuration error in the Vista diagrams as shown below. Possibly, the ION
and XML files have been updated in the new PME 8.1 system.

Cause: The Vista diagram refers to the old ION and XML files located at ...\config\translator
folder.

Resolution: Delete the ION and XML files from the ...\config\translator folder and re-do the
MDI configurations manually.

n Vista - supervisor - Power Monitoring Expert - [User Di;
File Edit Options  Wiew Window Help

EE B = B EE

SchnEtlaider PowerLogic™ ION Enterprise™
ectric

besim bopms

Alarms Current, Yalt, Pwr Dermand Energy Diagnostic a:tcvbotrok
Channel Current, Power, Power Factor VYoltage, Freq
Top Feed
PF (%) P (kwa) P (k) I {amps) I {amps) P (k) P (ko) PF (%) Panel-Main
0.0 [T — i —m—]| I [ oo ] viz|[ oo
[P - eonenil . v2i[ nov
DQ « Configuration error. An address was found for the requested reading butthe register does not exist, -- 7> W o
0.0 L7060 besim bopms o : EE;
0.0 000 & 000 0.0 elllchie. G o
0.0 0.000 0.74 1.84 0.000 0.0 v iN Tov
0.0 0.000 0.37 3.26 0.000 0.0
0.0 0,000 0.74 1.64 0,000 0.0 V2 RO DRY
0.0 0.000 0.37 3.25 0.000 0.0 V3N | 00V
0.0 0.000 0.74 1.63 0.000 0.0 Vin avg 0.0 4
0.0 0.000 0.37 3.24 0.000 0.0
0.0 0.00d 0.74 1.64 0.000 0.0 RN
0.0 0.000 0.37 3.27 0.000 0.0
0.0 0.000 0.75 1.65 0.000 0.0
0.0 0.000 0.37 3.24 0.000 0.0
0.0 0,000 0.74 1.84 0.000 0.0
0.0 0.000 0.37 3.24 0.000 0.0
0.0 0.000 0.74 1.64 0.000 0.0
0.0 0.000 0.37 3.28 0.000 0.0
0.0 0.000 0.74 1.64 0.000 0.0
0.0 0,000 1.16 4.88 0.000 0.0

Troubleshooting Hierarchies

Issue: Hierarchies Sub Meter tab is missing, and version numbers do not match.

Resolution: Clear the web browser history and refresh the Hierarchies cache by opening
Hierarchies from Management Console. Log in and press Shift + F5. Then reset IIS by nav-
igatingto C: \Windows\System32 and double-click iisreset.exe.

Troubleshooting Alarms

Issue: A message occurs when the ION_Data database contains large number of unac-
knowledged events or the Web Applications is not able to properly access the alarm data.

Environment: Web Applications and Alarms Tab

Scenario / Resolution 1:
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This can happen if the upgraded database (ION_Data) contains a large number of unac-
knowledged events. To determine if there are a large number of unacknowledged events, run
the query below against ION_Data. This will return the number of unacknowledged events
with a timestamp greater than the timestamp you have chosen.

NOTICE

DATABASE DAMAGE

* Do not perform this procedure unless you are familiar with SQL Server Man-
agement Studio.

* Always back up databases prior to performing this procedure.

Failure to follow these instructions can result in irreparable database damage.

select COUNT (*) from vAlarmLog

where AckTimeUTC is null

and Priority > 127

and TimestampUTC > > '<some timestamp filter;'

To acknowledge all of these alarms quickly, without having to use the Alarms user interface,
|Execute the following query:

Declare @CurrentDateTime varchar ( max )

SET @CurrentDateTime = GETUTCDATE ()

INSERT INTO EventAcknowledgement (EventLogID ,AckTimeUTC ,User-—
Name )

( SELECT a .ID , @QCurrentDateTime , 'supervisor' from vAlarmLog a
where AckTimeUTC is null and Priority > 127 )

This query will use the present UTC date / time as the alarm acknowledgment, and super-
visor as the account that performed the acknowledgment.

Once the alarms have been acknowledged, the Alarm Viewer will function normally. It is
recommended that you delete old, unwanted events to reduce the number of events that need
to be processed. Use the Trim function in Database Manager. Select Events and choose an
appropriate date range.

Scenario / Resolution 2:

If the server machine is on a workgroup, change the Schneider Electric services to run under
alocal Windows administrator account, restart the services, perform an iisreset, and then
check to ensure that alarms are coming in successfully.

Scenario / Resolution 3:

Check the Windows Host file in the C:\windows\system32\drivers\etc\ directory and check
the localhost IP address. By default, webservices only allows access from 127.0.0.1, which
is the default localhost. If the address is different than the default, the locahost address
needs to be added to the webservices web.configfile (suchas <add
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ipAddress="10.70.20.81" allowed="true" />)wherethe IP address is found
within the Windows host file.

After changing and saving the \host file, restart the Schneider Electric services and per-
form aniisreset to verify that alarm and event data are coming in successfully.

Troubleshooting Reports
Issue: Reports do not display in the Report Library.

Possible Causes: Incorrect licensing or the custom web report packs are not installed, or
properly upgraded.

Resolution:
Obtain the correct licensing.

Install the upgraded custom web report packs or delete the custom report entries from the
database.

Custom web report packs were not upgraded

Review the following scenarios to understand the implications of not upgrading custom report
packs:

Scenario 1: If the old custom reports have not been upgraded (i.e. they are not compatible
with PME 8.1), none of the web reports will be visible in the Reports Web application.

To successfully perform the upgrade without the custom web reports:
1. Delete the custom reports (templates + saved instances) on the source system in the
Manage Reports Ul (in Web Apps) before transferring the system.
2. Follow the standard SBS upgrade process.

The default reports on the new system will work as expected. Once the old report packs have
been upgraded, they can be uploaded and installed on the new system and they will work as
expected. (Internet Information Services (IIS) needs to be restarted.)

Scenario 2: The old system has a lot of saved custom reports and the client doesn't want
them deleted.

1. Try installing the old custom report pack from the source system on the target. If it
installs it might not work, however, the default reports will display. The SBS upgrade

can proceed.

Scenario 3: The field engineer completes the SBS upgrade with old, non-compatible custom
web reports. At this point, the target system will not display any reports.
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1. Determine which database table entries need to be deleted by opening the System
Log in Management Console or by looking at the database tables to identify the cus-

tom reports.

2. Delete the custom report entries from the RPT Report table in the ION_Network

database.
The default reports on the new system will work as expected.

Data Log Viewer Query

Issue: After completing the upgrade, an error occurs when trying to modify a Data Log Viewer
query created in or earlier.

Cause: A space was inserted before the ‘@ VCN’ node, and an older query will not have this
space.

Example: Old node name [Data Rec 1@VIP2QVCN *)--"]
Edited node name [Data Rec 1@VIP2 @VCN *)--"]

Workaround: Edit the node and add a space before the @VCN.

SQL User Mapping

In SQL Server Management Studio expand Security > Logins, select the Users (for
example, ION) and then right-click ION and select Properties.

The Login Properties-ION window opens. Select User Mapping and in the Users mapped to
this login section, select the appropriate Databases, User, and Default Schema based on the
following:

Default

EPSS ApplicationModule  EPSS _ AMApplicationRole, pub-
DataCollector DataCollector lic
ION_Data EPSS dbo Db_datacreader, EPSS,
DataCollector DataCollectorAccess,
public
ION_Network EPSS_ dbo Db_datareader, public
DataCollector
AMUser ApplicationModules AMUser Dbo AMApplicationRole, pub-
lic
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Database LT Role Membership
Schema
ION ION_Data dbo dbo Db_owner, public
ION_Network dbo dbo Db_owner, public
ION_SystemLog dbo dbo Db_owner, public
ionedsd ION_Data ionedsd dbo ION_DSD_Reader, pub-
lic
ION_Network ionedsd dbo NOM_DSD_Reader,
public
Report ION_Data Report dbo db_datareader, ION_

Reader, public

PME Segment Edition Note: For the EPSS Data Collector user, the mappings are available
only for Data Center edition and Healthcare edition (not for PME installations). The screen
below shows user mapping in SQL Server Management Studio.

l_;..-_g. Microsoft SOL Server Management Studio
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[ Databases & [y ﬂ} Users mapped to this login:
B D;CLI'_”W ﬁ Securables Map  [|Database | User Default Schema |
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& ##MS_PalicyEventProcessingLogin# #
& ##MS_Palicy TsqlExecutionLogin # I dbo _I
A BMUser I |_Metwor dbo dbo _I
A o ¥ ION_Systemlog dbo dbo []
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A NT AUTHORITYSYSTEM r mod
NT SERVICEYMSSCLEION
g NT SERVICE\SQLAGENEFION ¥ msdb IO dbo H
& Report - tempdb
A sa
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& PMESERVEROMMainkenance
[ Server Rales
[ Credentials = | Guest acoount enabled for: [0 Data
[ Cryptographic Providers
3 Audits =:> Database role membership for: 10MN_Data
[ Server Audt Specifications Connection [] db_backupoperator |
[ Server Objects Caver [] db_datareader
3 Replication i;\l::ESERVER\IDN [ db_datawriter
[ Management ) ] db_ddladmin
|£) SQL Server Agent Connection: . [[] db_denydatareader
PMESERVER\&drministrator [ db_dermdatawiter
3 View connection properties ] di_owner .
[[] db_securityadmin
[ 10M_DSD_Reader
[] 10M_Reader
Maintenance
Fiead d
v [[] mma_srchiver
[v] public |-
’TI Cancel |
|
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Note: If a “user exists” message is observed during the user mapping process, con-
tact Schneider Tech Support. They will probably have to delete the user from Secur-
ity > Login > User(s).

You can also use the following query to see if there are issues with the “user exists” mes-
sage:

ALTER AUTHORIZATION ON DATABASE::ION Data TO ION;

Engineering Client and Server(s) Communication

Once the Engineering Client installation is complete, follow these steps to ensure smooth
communication with the PME server(s):

1. Onthe Engineering Client, navigate to the $ : \Win-

dows\System32\drivers\etc directory.

2. Openthe \hosts file and edit it by adding the following details in the relevant order:
»Client Machine IPClient Machine long name
? Client Machine IPClient Machine short name
? Server Machine IPServer Machine long name
? Server Machine IPServer Machine short name
For Example:
»? 521.456.7.x clientName. <your domain>.com
»? 521.456.7.xclientName

» 521.456.7.y serverName.<your domain>.com

»? 521.456.7 .yserverName

Distributed System Note: The \hosts file must be edited
in the primary server as well as the database server.

3. Onthe primary server, gotothe ..\Schneider Electric\Power Mon-

itoring Expert folderon the serverand enable Sharing to "Everyone."

Distributed System Note: Make the following changes on the Database
server.
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4. Onthe PME standalone server, change the SQL Server Configuration Manager set-
tings to establish the remote connections of the SQL server named instance (for

example, PMEServer\ION) with the Engineering client.

5. Goto SQL Server Configuration Manager and click SQL Server Network con-

figuration.
6. Expand the tree.

7. Click Protocols for IONE and enable the following options:

» Shared Memory

»? Named Pipes

» TCP/IP

»” Set VIA as disabled (by default)
” Right-click TCP/IP

?  Go to Properties

? Navigate to IP Addresses tab

? Make IP3 IP address same as Engineering Client IP Address

» Enable TCP port as 1433.
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= Sql Server Configuration Manager
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8. Check the remote connections of the SQL server 2008 R2 named instance (for
example, PMEServenION) of the new PME server with Engineering Client as men-

tioned below.

9. In Engineering Client, open a new Notepad file and save it as a . ud1 file.

a. Open the UDL file; you need to manually enter the standalone server
name with the SQL instance name (for example, PMEServenION) if

it is not listed in the selection menu.
b. Select the Use Windows NT Integrated security radio button.

c. Select the ION_Data option from the Select the database on the

server dropdown list.
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=g Data Link Properties E1

" Provider  Connection |.-’-‘«dvanced| All I

Specify the following to connect to SOL Server data:
1. Select or enter a server name:

Standalonehion
2. Enter infarmation to log on to the server:
% Use windows NT Intearated security
" Uze a specific uzer name and password:

ﬂ Fefrach |

User name: I

Password: I
[T Blank password T Allow saving password
3. (% Select the datahaze on the server:
[|ON_Data -]
€ Attach a database file as a datahaze name:
JlON_Data

Using the filename;

| _

Test Connection |

ok | cancel Help |

Click Test Connection.

Once the operation is complete, you will see a Test Connection suc-

ceeded window.

10. Install PME 8.1 on the Engineering Client.

If the following exception displays in the Diagnostic viewer on the Engineering Cli-

ent:

« el

Status : Could not load file or assembly 'AD00E. Version=7.0.3300.0. Culture=neutral. Publick eyT oken=b03f5f7111d50a3a" or one of its dependencies. The located assembly's marifest definition does not match the assembly reference. (Exception from HRESULT: 0x80131040)

To fix the exception:

1. Onthe command line, create a new directory called $: \Win-

dows\assembly\GAC\adodb\7.0.3300.0 Db03f5f7f11d50a3a.

2. Copy the adodb.d11 file locatedinthe ..\Schneider Electric\Power Mon-

itoring Expert\system\bin foldertothe newly created directory \GAC).

3. Log in tothe Diagnostic viewer and make sure that the device status is active.

Device Diagram Customizations

Issue: Customizations to default device diagrams are lost when the diagrams were moved to

the new system.
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Cause: This issue can occur when a customized default device diagram on the old ION Enter-
prise system is configured to open from a grouping object that has the “Action” set to “Open
Diagram for Meter Template”.

This option will use an automatic mechanism in ION Enterprise to find the default device dia-
gram based on the device type, firmware versions, and other settings. If the new PME sys-
tem has an updated version of the default device diagram and the automatic mechanism is
used to discover it, then the new one will be opened which does not have the customizations.

Workaround:

Option 1: Change the links on the new system to link to the specific default device diagram
that was transferred over from the old system. Choose the option “Open User Diagram” in the
dialog and then select the relevant diagram from the old system. The advantage here is that
this requires relatively little time and effort. The downside is that you will not get the benefit of
any bug fixes that led to the creation of the new diagrams.

Option 2: Copy the customizations that were done to the old diagram to the new diagram in
PME 8.1. The advantage here is that you get any bug fixes that triggered the creation of the
new diagrams. The downside is that you have to manually recreate the customization.
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